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Abstract 

This report discusees the dewlopment of the '&jbpec Computer Aided Software Engineering (CASE) tool, 

which assists with the development and documentation of softwate in an environment where software quality 

is closely monitoted, perhaps by independent reguiators. The tao1 can assist in the development of a broad 

range of software, but is targeted at the software that imptements mathematical models. 

W p e c  generates rtquirements specificatîons, design specifications and compiiabIe code in a structureri 

form whiie ensuring consistency between products. 

The onginai application of w e c  was to Bssist devetopers of soRware modeling a repository for Canada's 

high level nuclear waste to achive compliance with a quality assurance standard ~pecified by goverment 

reguiators. 

This Iepoh details the form of documentation products produceci by 'QXqec and ai1 required inputs. It 

discusses the processing that "QXspec uses to convert înput înto finai products. The method of ensuring 

consistency between products is reviewed. htmction is provideci for operating w p e c  using a graphitai 

user interface. The significance of the work is d i s c d  and directions for hiturc! development are suggoited. 

Some of the requirements of '&Xspec are continuing to evolve, As such, the development is of necessity of a 

prototype, or spirai mode€, nature, This report acts as a s ta tu  report on the development of ï$Jspec and 

provides a reference for both users and programmers. 
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1 Introduction 

The Deep Geologic Repaeitory Technology Program ( D G m ) ,  addnistered by Ontario Pawer Generation 

(OPG) , is chargeci with developing technology to deal with Canada's high level nuclear waste. Atomic Energy 

of Canada Ltd (AECL), ns a major contractor to the DGR!I'E', has accumulated considerable expenence 

developing computer programs to mode1 a deep geologîc repository for used luel [8, 91. These programs 

require software of dernonstrably iugh quaiity to support tesults pmented to the C a d i a n  Nuclear Safety 

Commission (CNSC) and the public. 

ln 1999 the Canadian Standards M i a t i o n  (CSA) adopted astandard (CSA N286.7) [41 lot the development 

of nuclear safety related computer progranm. a scxipe that included many DGRTP models. While the 

software development procm used previously was considered robust, it required reiinement in order to 

achieve cornplianuice with the standard. 

The 'Qjbpec project & to a d d m  the issue of compliance with the CSA standard in a general way. The 

objective is to develop a cool to support a cornpliant software development procedure while impoaing a min- 

imum of additional overhead. The tool must support the use of diagrams and/or gmphics and mathematicaI 

notation. WhiIe ?J$spec is optunised to meet the particdar requirements Bssociated with modeling the 

d i  of Canada's nuclear fuel waste. it is hoped that ïj$Gpec wiii End more general usage- 

The principles of the CSA N286 standards require that 

0 Aii software products be subject to a review by quaiSeci staff, 

a Genealogy of products be preserved and 

To adhere to these principIes, products must be clearly delineated and contmtied- Where multiple products 

s h  common components, this can become clifficuit to achieve- For example, the same mathematical equa- 

tion might appear in the theory manuai. requirements specification and design documentation. The equation 

may have been developed by one author, the requirement specification by another and the design documen- 

tation by someone else. 'I1oJMg this relationship reqinres chat the equatian be mahtained separately h m  

the products that teference it- 



The requirement to document the INROC [16, 171 cornputer program in a CSA N286.7 cornpliant mrrnner 

has Ied to the development of the 'Q$spe<: Computer Aided Software Engineerbg (CASE) twl. W p e c  

implements support for wRware development methodologies used in the development of INROC documenta- 

tion, including rquirernents specification, design description and manuals. W p e c  is designed to allow for 

enhancements Landling other software development products outüned in CSA N286.7. and may be expanded 

to include other methodologies (including object oriented approaches). Tt is intended to be sufnciently flexible 

to permit e h c e m e n t s  to include other ph- of the software development life cycle. 

1.1.1 Commercial Toob 

Several cornmerciai CASE twis have been examinecl, i nc lud i  DecDesign[61, GraphicaI Designer[ll, Sohare 

W u g h  Piccures(l1, 271, and Teamwork[3]. Each of the examined tmis was found to be deficieut in one or 

more critical arcas: 

Lack of support for scientific and mathematical notations. The nature of the models demands that 

mathemeticai notations ( e.g., Ai (t) = Ji [F/N(r)]dr ) be permitted in speciücations, including 

diagrams. 

[iisufficient acwuntability. The prîncipte of ownenhip and amuntabi ty for products is not rtrictly 

enforceci. While a record of who updated products is often kept, the process control is often inadequate. 

For cample. anyone who shares a data dictionary might be permitted to update any entry without 

regard to individual ownenhip of particuIar entries. 

r Aasembling large products fmm smder components is not adequately supported. In t h  experiencs 

accumdated with the M O C  pro- and itrs predecessors [Ml, many software defects were found to 

be the readt of transcription emrs  between pducts.  

r Insufficient consistency checking between products. 

'Q$spec is based on the Yaurdon/DeMarco structurecf d y s i s  methodoIogy (5,301 for software development. 

Many modeis have, to date, been describecf using a m d e d  Yourdon/DeMarco methodology [15]. Although 

00 methods muid perhaps be more appropriate for some models, priority is gÏven to the more comrnon 

smictured anaiysis methadology. Products ~asociated with thïs methodology are: 

O Data fiow diagrams (DE'Ds), 
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a Structure charts- 

0 Module design descneScnptions (Design Specificatioas), and 

Data dictiouary Listings. 

Data Flow Diagram (DFIl)s and blini-specs comprise the requiremeats specification, whiie Structure Charts 

and Design Speciûcations specify the design. Data dictionary listings may be separated into requirernents 

and design, or combineci into a single pmduct. 

Although Object Oriented (00) analysis and design is appropriate for many sohare appIications, there are 

stiii applications for procedure/flaw based software. In particuiar. wme modeis which are basidiy linear in 

structure, including many scientific models, are k t  described using non-00 techniques. 

Module design descriptions iorm ciu engineering blueprint ïor aide [20,24I. A programmer serves anakgously 

to a construction tradesman, wtio implements the design. This phitosophy haa resuited in design documen- 

tation which cIosely parrillels the bI code or pseudo-code [191. The design specibtion and compdable 

code c m  be sufficiently similar thnt creating and maintainhg both can be an inefficient use of resources. 

The two must aIso be closely monitored to ensure that they are synhnized. The dupiication O t effort must 

be reduced and the h c e  of incotisistency between products must be addressecl. 

1.1.4 Experience with S o h  Qwfity Controt 

Many models and d t e d  pmgrams are m m  clearly speciKed using mathematicaI abstractions. Whiie it 

is p i b k  to express Ai (t) = Ji [F,IN(r) +&A, (7) - cm (r)l exp (-Xi (t - r)) d r  in plain engüsh text, 

it is much more convenient and expressive to utifiï the mathematicd notation. It is therefore imperative to 

support the use of thii kind of notation in software development products, inciudii rrquirementç and design 

specincations, as weli as manuais and other documentation- The tmsc@tion of mathematical notation bas 

proven to be emr-pmne 1181, and m m  be minimlzed. 

The reIationship between Requirements and Design leads to other cornmon items between theü speciiïcations, 

as they are Mereut me osa ions of the same system. For example, a requirement specification might speciS 

a 'density', denoted as 'p', with physicd uni& '9 the design might t h  specify a r d  variable tho' with 

r L  .orno awDih;ls ~nr l  rlooi.Ünk Mpny M~-&D[ C+-. rMI mt.intain r. mrnmnn nnts r c  



handle some of thia overlap between Reguirements and Design. This approach, unfortunateIy, can compm 

mise the principle of responsibity for products. in an environment where the genealogy of products must 

be known, fibaring a common Data Dictionary must be carefully controlled, or multiple data dictionaries can 

be used. in the p s t ,  DCRTP hss used multiple data dictionaries. but this has led to transcription related 

defects, and a pmpensity for dictionaries to fa11 out of synchronizetion. In addition, any attempt to merge 

dictiomuies hw isad to m l v e  dupiicate entries. 

For the madels implemented for a single environmental assessment, AECL invested over $1 million to venfy 

soîtware by unit testing [la]. The result was far ftom encouraging. The contractor (Science Applications 

International Corporation) found many defects in the documentation and transcription between products, 

but nothing that couid materially d e c t  resdts. An embarrassing number of defects was reported. 

The format of software documentation may have a much shorter lifetime than the software itself. Docu- 

mentation for some long iived Fortran modules have b e n  published in M-11 (a word processor that is 

no Ionger supported), Wordperfect, MS-Word, and others, al1 with diaerïng styles. Software supporting a 

single study has been published in severai diierent formats. This experience suggests that the content of 

documentation shouId be separated bom the presentation; the information shouid be coiiected independently 

and assembleci according to the current format in use at the time of final publication. 

Attributing m e n h i p  and responsibiiity for products is a basic prïnciple of the CSA N286 standards. In 

order to dectively reuse common information, while remaining faithhii to this principle, it is helpful to 

coiiect, in very s d l  pieces, information used to assemble software products. The dependencies between 

products and components are easier to manage if the shared information is not contained in large packages. 

Keeping the granularity of components very fine aiso alIows ownenhip to be tracked. without assigning 

ownenhip to more than one individual. 

Verification of consistency between software products has been a costly and enor prone procedure (181. The 

number of products has been high, and verification has  not been sufüciently autometed. If a high grandarity 

of componenki is desired, then automation is clearly required. 

1.2 Ohjeetive of the Study 

The objective of this study is to develop a tool to assist in the deveIopment of software and essociated 

documentation cumpliant wîth the CSA N286.7 standard [41. The tooi must address some of the deficiencies 

obeierved in commercial CASE toois which mah t h e  twis difncult to depioy for the deveiopment of s o h  

tbat implements mathemeticai models. 



1.3 Signiiicance of the Study 

The QXspec tool describeci in this report is a stepping stone to cornpliance with the CSA standard for the 

development of nuclear safety relateci computer prognuns. This compiianœ is expected to be required to 

support h u r e  licence applications to the CNSC. 

The tool offers a viable CASE capabity For computer pragrams which are best specified with intensive use 

of mathematical notation. 

1.4 Limitations 

m e c  is a prototype. May fatures in bath the underlying technoloa and in the usability remain to be 

a d d r d .  Some of the requirements of w p e c  are continuhg to evotve, As such, the initiai development 

is of necessity a prototype, developed using a spiral modei. This report is a snapshot of the current state of 

m e c  development, 

Currently, QXspec c m  only generate design documents for Fortran-77 code. in the necc stage of develop 

ment, this will be expanded to inchde some Fortran-90 extensions, including 'modules'. in the future, this 

is expected to expand further to inciude other Ianguages. 

The Graphitai User interface (GUI) is in an earfy stage of deveIoprnent. The e d i t o ~  are not sophisticated, 

with no search-and-replace capabiiity. DeveIopment of graphitai products is based on non-graphitai editon 

and no preview capability has been implemented- The system is usable and eff~tive, but there is still m m  

for development and further msearch. 

The system has not yet been integrated with asecure configuration management system. Effective sharing of 

data and meaningiui sahare audit capabities await this development. This muld be expanded to integrate 

with a change mntrol system. 

The data proceraiing and the GUI are cumntiy h t h  nui on the same machine. A client/server mode1 might 

be an important development in the biture, i~&ning the compute and I/O intensive pmcessing to a arver. 

1.5 Reiated Work 

Aside h m  commercial CASE toois, the work of Wecïnga [29] is notabIe, The Toolkit For Conceptuai Mod- 

eiing (TCM) is Mplemented to support the Tooikit For Requirements And Design Engineering ( W E ) .  

This tao1 generates several different diagram types and even performs some consistency checking of dnta Bow 
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ematical notation and does not Uitegrate weU with an acceptable Data Dictionary. Even so, a modification 

of TCM may pmvide a usefui interface for 'Qjbpec- 

Also a possibity for a drawing interf'e, WQ$Ccad [14] provides a GUI capable of hand i i i  math-centric 

E%l$$ [13] labeiing, but would requin some modification. Like TCM, FQ+cad is also a single platform tool, 

-ng under MicrosoR Wïndows (MSWin). 

Another CASE tool w h k h  uses Java as a front end iir the ArgoUhiL [22] design tooL ArgoUML is exclusively 

an object orienteci too1. The interface is mature and allows the user to interact directly with diagram 

components. Siice ArgoüML is an 'open source' project, the code is available. 

î&Xqec is built on the E%&X foundation with a pair of signifiant extensions. The Noweb [21] system 

for Literate Programming is used to separate module Design Specifications and compilable code. Graphics 

extensions suitable for the generation of diagrams are provided by the xypiir [23[ package. 

1.6 Notations 

ï&pec input 6Ies are ASCII Mes. organized as 'fieId: value' pairs. When speciljring the content of these 

fiIes, the foUowing notation is used: 

FieIdName: desdesmption of value 

The 'description of value' is containeci within delimiters as followsr 

0 brequid k l d ,  may appeor o d y  onœd 

0 field, may appear more thon o n c e  

0 koptiond fieid, may appear more than o n -  

Where sets of 'field: vaIue' pairs are groupeci, the group is named in bold type within brackets for later 

-on. The same delimiters are used. For suunpIe: k[group name19 specifies a group of fields which 

is required and may appear more than once- 

These deiïmiters are used rather tban the more conventional bracIret/brace notations to allow for non- 

ambiguous delimitation of content, which uses brackets and braces. 



1.7 Organizatiori of the Repart 

The remainder of this report is organized 8s foriows. The underlying technology of Wpec is detailed in 

Chapter 2, including the requirements, design, and m i o w  Me formats. The user interface for 'QXpx was 

implemented separately [rom the underlying proeessing and is decaüeà in Chapter 3. Chapter 4 offers some 

concludii remarks and suggests some directions for further development. Appendices contain sample code 

Whgs and examples of the longer 'QXspec inputs and products that are not hùiy shown in the text. The 

final appendix provides instmction for instding QJCqxc* 



2 Specification and Design 

2.1 The T i e c  CASE Tool 

2.1.1 Requirements Specificatmn f i  T i  

The 'QJcqec application is baseci on the folIowing requirements: 

O Assemble user inputs to generate consistent publication quality Data Flow Diagrams (DFDs) and 

Process Speciiications in a madified Yourdon/DeMarco Format. This inchdes support for 'Ieveled' 

diagrams [30], which allow a parent' pracess to be decomposed in a 'childl diagram. 

O Permit the use of composite data fiows on DFDs. Break composites as required for a child DFD or 

Pmcess Specification (Mini-fipec). 

O Ensure comîstency between the data Born shown on the DFDs and Mini-ripec, 

O Generate Structure Charts and Design Speciiïcations. 

O h u r e  consistency between the Bows on the Structure Charts and the Design Specifications. 

O Ensure consistency between the Design Specifications and executable code. 

O Permit the use of mathematical notation in al1 products. 

O Aiiow sharing of mathematicai formule between products. 

O Permit ownership of pmducts to be tracked and reporteci. 

O Allow components under development to reference other mmponents from a variety of sources. Stable 

libraries of companents should be supported as a default, which new components under development 

supercede. 

O Support the use of Fortran m a target implementation Ianguage. 

O A user interface must be provided that dows users ta interact with w p e c  in an intuitive way. The 

interface should require training before a user becornes pm6cient. 

O Information to be pmcemd by l&Xspc is assumeci to have a long lifetirne, perhaps exceeding that of 

'QXspec itself. The information must therefore be stored in a fonnet suitable for later pracessing by 

other program, or perhaps the human eye. 

O A 'batch pmcesing' option rnust be supported that can capture and log pmcessing detaiIs. 

O Learningttirves for both users and implementem shouid not be excessive. Maintenance expertise should 

not be difEcuIt to recnrit or train. 

8 



Coding languages, libraries and toole shouid be freely avaiiable. 

a The m m  must be portnble between computing platfonns. Mthough the desktop environment is 

dominated by MS-WIN, king locked to any single system restricts deployment options and reduces 

the number O€ potentid users. Also. if the application were divîded into client and semer portions, the 

server environment is likely to be more heterogeneous. 

Some preferred attributes O€ W p e c  are not required in an a h l u t e  sense: 

1, The application sbuid nin in ieasonable' t h e  on common desktop cornputers. This is a difücdt 

requirement to quantify, since the term 'reasonable' is subject to interpretation and what is common 

on the desktop differs in time and location. Even so. it can be said that a responaive application is 

preferred over the aiternative and that some design effort can rewnably be applied to achieving the 

k t  passible performance- 

2. The implementation should be maintainable- Code implemented in an uncornmon ianguage is more 

diEicuit to maintain, as propmmen are l es  likely to be familiar with it. 

3. There shouid be a migration path to allow a gradua1 transition from existing methosis. The 'cold 

turkey' implementation of new toois is rarely well received. A pilot project style of implementation is 

preferred, as it aiiows operationai difikuities to be deait with before a large commitment is made. 

2.1.2 Architecture of  TEXIpec 

?EKspects GUI is discussed in Ckpter 3. which captures interactions with the user. Most of this interaction 

consists of displayhg and manipuiating 'component' files, which form the inputs for the w p e c  scripts that 

select companents and =mble them into products. 'ïhese products are primarily BQX [131 or Noweb [2I1 

input ûies, which can be p o y t - p d  to produœ output suitable for vie*, pcînting, or conipiling. While 

these outputs may be riewed as being intermediate, they are intended to be reteined, as places 

commentary in t k m  to record the deteils of 'l$jGpec processing. 

While the GUI is a convenient way to constmct components and initiate processing, it can be bypassed if 

cequired The components can be generated by m y  means that can generate an ASCII output file, including 

a text editor. More importantly, the processïng can be controiied by any meaus that can initiate a process, 

with no requirement for interaction with a GUI. When processing mmy components. or when a log of 

ptoeessing is required. thb 'batch style processing is a usefui aitemative. 



Neither the Q$spec scripts, nor 

the GUI can diaplay or print the 

products. F i i  2.1 indicate. 

that an intemediate script, which 

is intendd to be edited by the 

user, initiates TÉXapec to pro- 

duce the pmduct files, then con- 

trois post-processing as approprï- 

ate. This Bexibity allows the 

user ta integrate W p e c  into ex- 

isting procedures. For example, 

if a static code analyzer such as 

Floppy [2] ia in use, it can be run 

autamatically on code as it is gen- 

erated. interaction with a version 

contrai system might be desireci, 

or the user m y  even wish to corn- 

pile code as it is generated. Al- 

tematively, processing that is not 

-_- 
Figum 3.1: Sehamitic view of the 'l)$Capec ardiitecturs 

needed cm be removed, such as temoving documentation generation (including EQX processing) until the 

d e  is stabk 

AU input files for are human readable. That is, they are in ASCE format, organized in 'M 

vdue' pairs, which is intendeci to ease visuai interpretation, The input files can be created using a standard 

text editor and reviewed easily due to the intuitive syntax, without the overhead of an eIaborate intetfece. 

A more sophisticated interface for handling l'&pec files, which can be large in number, has been deveioped. 

Sta,  the ASCII format files can be edited or read by readily avaiiabIe tooh and do not require mec 

pmgrams to interpret. 

En order to support sharing of equations and data dennitions. while tracking ownership and respoosibïïty 

for content. QXspc supports a Ene grandarity of components. Components are tracked independentIy by 

piacing each in a unique file which is mapped by the file name to the name of the component and by the file 

name 'extension' [in the tradition of MSDOS or CP/W to the type of component. 



T)$apec components. with associateci ûie name extensions, are: 

0 Requirements Data Dictionary entries (.Ad: Section 2.24, 

0 Design Data Dictionery entries (.ddd: Section 25.2), 

0 Equations (.teq: Section 2.2.41, 

O Process Specifications (.ms: Section 2.32). 

a Design Specifications (.ds: Section 23.3). 

O Structure Charts (sic: Section 2.3.4). and 

0 Manuais (.tex: Section 2.3.5). 

in order to share components between individuais and projects, the location of these ailes is Bexibk A 'search 

list' provides a l i t  of directories to be searched seqwntially for component files. This is oRen referred to as 

a 'PATH'. A dinerent 'search Est' c m  

be provided for each component type 

in a file named '.TeXspecrcr, as shown 

in Figure 2.2. 

This mechanism is intended to be 

supplemented in future versions OF 

QXqxc. It is intended thet c o m p  

nents should be 'installed' in a con- 

figuration management systern for fu- 
Figure 23: h p l e  -LhX.pecrc file, ipedfying wuch I h  by comp* t u e  reference. Once installed, depen- 
nent type 

dencies betwwn components would be 

monitored to ensure that the creator of a product is nut surprised by a change in hii pmduct caused by 

a change in e referenced component (a 'subcomponent') for which someone eise is responsible. For the 

moment, however. the directory search üst mets the requirement, aiiowing components to reference other 

components h m  a variety of sources. This mehankm will continue to be supporteci as a mrking a m T .  

That is, the 'search List' will be set up to speafy that working d i i o r i e s  be searched first, foilowed by 

librarïes under the configuration management system. 

Camponent files are each assignai a version of format 'BINA', where 'NN' is a two digit integer indicrrEing 

the instdation nnmber and 'AT is a singIe character 'draft letter' indicating changed versions between 

instaüations. This corresponds to the scheme used at AECL to configure software versions manualIy- 



To keep track of the mmponents used to assemble a mpec pmduct, the WQX input üiea generated 

Each formatteci pmduct has an additional configured component. The i#&X 'clans' .ch file used to specify 

the format of the pmduct (in particuiar the page header) must be instded into the system that 

TEXspec will tue to pmduœ products, At the upper right corner of each generated product, the version of 

the li3'c1ass' file is printed. 

by T&Gqec moddes contain commentary that identifies aii refërenced components and the version of 

As digcussed in Sectiou 1.1.4, minimal formatting information is stored with the 'QXspec compooents. 

Formatting is a function of the processing of the components. The hope is that as documentation formats 

evolve, the criticd content of the mmponents shaii not be rendered obsalete. 

I - + ~ t u . . . . ~ t l ~ U i L I y ~ 8 1 i i . - i . L I . I o n U r 4 t  *..- - .* xitw*_ror\~m.Ii.c\-NL.u.te)r.C a rri u 
1l utmn 104 
u. .. gpil* -- *. . . r r \ ~ ~ u D 1 \ M r p \ I P I I C \ I n r O W C \ M i i ~ . *  au *,-. - 0- 
a.-. h k  ih. lnYIiClOldlMc/VO101I~IWrlr.b16 o u  
9 * s ~ i - . l u m u 4 / œ 4 o a f v l v w o . I i ( i u ~ I d ~ . ~  O U  
r... n m / L i i b . l l n u ~ m m v w o . I ~ I d m . ~  o u  
9 % ~ - ~ ~ W Z S U V ~ U W V L ~ I W S ~ I M I ~ ~ + ~ M  0- 
a.. . n h ' i P ~ l n u q l o u o u n m ~ a m u ~ / o D I l r r ~ r . ~ ~  ou 
a... n r r - ~ ~ n r i r œ l c u m M ~ / - ~ I ~ . ~  O n  
b.. . n h - ~ l ~ s l o u ~ ~ l U o Z L a ~ ~ ~ I ~ l - . ~  ors 
b .  * * r ~ ~ i k ~ n r r O y n - I - 1 9 1 ~ . 0 ~  o u  
m... i r l a i _ h . / R N ~ ~ I ~ I W I ~ . ~  OIF 
b.. . U r h _ k l ~ I o u O y i n ~ I U a U y I d I . . ~ . Y  O U  
b... w t r r  ~ I U I W ~ ~ ~ ~ O U ~ I ~ I ~ . ~  OU 
L.. * r / ~ ~ i b I l n u ~ ~ Q l / V l u W Z O S l U o Z L m n y I i r U ~ t . d c  O u  

Many scientific modela benefit greatly fmm the abiüty to incorporate mathematical notation in their speci- 

fication. One of the requirements of W p e c  is to support such notation in al1 products. To be compatible 

with the 'human readable' design decision, a notation is required that stores such information in ASCII 

fotmat. This information must then be translated into a flexible ptesentation format. 

the W p e c  module that essemblecl 

them. A date-time stamp is included 

and is also placed on the generated 

product (in the upper left corner} to 

uniquely associate the BQX Ne with 

the associated product. By retaining 

the MQX file. it is possible to audit 

Since the JX)# system is aiready mature and offers leverage towacd meeting the requirements stated in 

section 2.1-1, 'lj$&m produces documentation via BQ$. 

Flgure a.$: Top ofa I Q X  file pnerated by -, ihowing vemiom the content of any product- 'J'k is 
of componont. 

dernonstrated in Appendix B. 

To keep code synchrooized wîth mmciatei documentation, a üterate progremming [IO, 121 methodoIogy is 

ideal. A singie file is used to generate both a Design Specification and compilable code. Fortunately, severai 

systems aiready eiast to support this method in a M&X enviconment- The Noweb system was seIected 

because it is not sensitive to pmgnunming Ianguage, aiiowing 'QXspec to evolve (in the future) to hande 

Ianguages other than Fortran. An additional benefit of adopting Noweb is that mu& of the syntax for the 

h i g n  Specification Ne (Section 2.3.3) is dehineci in Noweb, reüeving î$JGpec of the cequirement to define 

sucfi synkut 

Components are processeci by T)$qec moduies according to the Uow specitied in P i  2.4. Users oi 

12 



Qjbpec provide content in components in the 'Shared Components' and 'Product Definition' categories, 

which together comprise the ï&Xspec inputs. The 'Shared Components' are intended primarily to be refer- 

e n d  by the 'Product Definition' [iles- 

The inputs are processeci into 'Products' by Tj$bpec- These pmducts are hted in F ' i  2.4 and correspond 

to the products defined by Yourdon [30] and Page-Jones [19I, plus the Fortran code. Note that the output 

h m  'Q#spec is not publishable (or compilabIe), but musc be past-processeci by i8QX md/or Naweb to 

pmduce ônal products. 

Figure 2.4: m~lpec flow, Indiuthg the m&e d p t r ,  4 t h  the mhtiomhip of inputs and outputr 

2.1.4 Implemantith lanuuage 

The main 'QXspc proce- is performed by modules which have been implemented in Pradical Extraction 

and Repart Language (PERL) [a]. The seiection of PERL was basxi on a number of factors: 

a it daes not confüct with the requirements stcrted in m i o n  2.1.1 and 

it has sufncient flexibility to act as a generd purpose languege. 

For the purpose of developing a user interface, PERL is wt as gaod a fit. Although a simple GUI can be 

implemented in P E U  using W i n g  Iibraries. the regirired GUT is not suniciently simple. The Tj$kpec GUI 

is implemented in Java. The seiection of Java was b d  on a number of factors: 

13 



a it does not confiict with the requirements stated in &-on 2.1.1 and 

a the tuisociated 'Swing' [7] library can be used to deverop a sophisticated GUI. 

Some T&KC input files are intended to b shaced. ThBt is, they are refetenced by other input files (sec 

Section 2.3). This relationship is illustrateci in Figure 2.4. 

2.2.1 Requirements Data Dictianary 

Although a Data Dictionary hing (Section 2.2.3) is avaüable as a stand-alone product, the primary use of 

Data Dictionary entries is to be referenced by other components such txi Mii-specs or Data Flow Diagrams. 

Each entry is contained in a file name-ndd where name is the argument in the 'Name:' h e .  

S@az of Reqrnrements Data Dictionary (.nid) jile 

Name: 
LabeName: 
Mat mame: 
LongName: 
Version: 
Project: 
Subproject: 
Authoc: 
Date: 
Implementer: 
ImplementDate: 
Reviewer: 
ReviewDate: 
CompoaiteOfi 

oshort name in ascii format - rn-d fw unique identifimtiona 
Dname to appear in diagmmr ( i f d i f f m t ) a  
+name using rnathematieal notutibn e n t d  in B w  format+ 
pdescriptive n m e  in ascri format - up to a sentencea 
ouersion number f i  tmcking histoq - oppean o n  listingsa 
~ ~ e c t  identi jbi im~ 
p ~ u b - p ~ e c t  identi&diona 
oauthor's namea 
odate that the m t y  wcri witlena 
~ f u i l  name of  person who input Uiis entnj into the sys tem~ 
odate thot the entry ww c n t d  mto TeX~pec~ 
+fidl nome of nvieu~er+ 
+date of 
+comma delineated Iut of ohm Repuiremenb Dota ht ionury  

entry 'Name's i f  îhe entry ù o m p o s i t ~  of other entries+ 
+SI unth endosed uiûiin square btuckets+ 
+&scriptive data type e.9-, ' i n t e g 6 -  

1 Description: o f d l  &scnpt& - up b a pa-pha 

An example of a Reqiiirements Data Dictionary entry is shown in Figure 2.5. The example is a 'composite' 

entry, compaaed of severaI other entries. Note the optiond 'LabeiName' field is used to produce labels on 

Data Flow Diagrams which diner h m  the 'Namer- T@spec requires that name-nld be a vaiïd file name. 

but the daah in the 'sgAlphar might create an in@ name.rdd Using 'LabeiNamer prevents the potentially 

offénsive Wtax from appearîng in the 'Name' 6eId, but diagram Iabels can contein the drrsh- 



2.22 Design Data Dictmnary 

Much iike Requirements Data Dictionary entries. Design Data Dictionary entries may appear in a Data 

Dictionary listing (Section 2.2.3). but their primary use is to be referenced by other components such as 

Design Specifications or Structure Charts. 

A Design Data Dictionary entry may reference a Requirements Data Dictionary entry via the 'Requirements' 

field. if thii is done, any missing fields in the Design Data Dictionary entry will defauit to the value round 

in the specified Requirements Data Dictionary entry. This is particdariy wful to avoid transcription and 

syachronization problems with the 'MathName' and 'Descriptionr. Fields which are specified in the Design 

Data Dictionary supercede aoy inherïted defauits. 

Currently, the 'CompiteOP field is supported in the Requirements Data Dictionary only, and Ïs unsup 

porteci in Design. As QIhpec evolvea to support programming ianguages with more advanceci data structures 

t h  Fortran-77, this wiii probably change- 

Each entry is contained in a nle name.ddd where nome is the argument in the .Name' Lue, 

'Che dictionary can specify a constaat due,  or a 'conditionr may be placed on the value. A 'w~dition' is 

interpreted as a a precondition' to moddes for whîch the variable is used as input and a 'postcondition' to 

maduIes ess-gning a value to the variable. Thk is d y  a physï& Iimitation on the range of valid d u s -  



S@az of Design Data Dictionary (.ddd) Ne 
Namer 
LabelName: 
Mat Mame: 
LongName: 
Version: 
Project: 
Subpmject: 
Author: 
Date: 
implementer 
IrnplementDate: 
Reviewet: 
ReviewDate: 
Requirements 
PhysidUnits: 
D a t a m e :  

Dimension: 
Fie: 
Cornmon: 
Value: 
Condition: 
Descript ion: 

~ d m t  nome in ojcii format - minimal fm unique identifimtionu 
+name tu ûppenr in diugrtams (q d i ' m t ) *  
+nome wing modhemdiml notation entend in format+ 
f de script nie m e  in arc% format - up to a sentences 
buersion number for tracking histmy - appeanr on listingsa 
bpml*d identificatim~ 
~sub-p+t identiJîtxtiona 
~mthork full namea 
 te îhat îhe entry waa un+ttenQ 
r > fU  name of person who input thts entry into the systemu 
buàte ffiat fhe entry uias m t d  inta TeXipec~ 
+NI name of reviewer+ 
rdate of r m i ~  
+ 'Name' of amwponding Repuipemmts Data Diclionary e n t w  
+SI units enciosed &in square brackeb< 
 data type sttilahle !or program design in tanjet longuageu 

r>dim&ing infopm4tionu 
+for s h a d  (COMMON) vaMbIes - Jüe to contain definition+ 
+name of Fwtran COMMUN block to contain data4 

In mxs where the variable cari be directly mapped tu a Requuements Data Dictionary entry, the 'Require 

menta' fieid can be used to speci& the mapping, and any common fiel& 8t.e Uiherited h m  the Requirements 

Data Dictionary (uniesa owrridden hem). 

An example of a Requirernenta Data Dictionary entry is shown in Figure 2.6. 

N u :  *WBA 
ni-: QaIpha 
q-: nt corifident a f o r  dph. rrdiolymis 
viriion: 01C 
DmjmoÉ: CU 
-: MAOC 
&athar: a.t. o u v u  
Dah: ODtobrr 25, 2000 
*lm-: S.E. Ou- 
4 l m t o a t m :  - 25, 2000 



2.2.3 Dietimwy L i i g  

Data dictionaty entria are incorporateci into other pmducts, but can a h  be essembled into a stand-done 

pmduct. T&Gpec provides a moduIe 'formatDD+pl' which provides listings of Data Dictionary entries. Tt can 

a b  pmvide a cmreferenee, showing the Pcofess Specifications (Section 2.3.2) and Design Specifiations 

(Section 2.3.3) in which they occur (optionally colour codd to hdicate the direction OF Eow). 

A suflicient number of fields exim to make a complete listing impracticaI to tabulate on a single page. To 

eaae thia pmblem, formatting on "legaln size sheets ia supported. and the default orientation is Iandscape. 

Even su, the user is obiiged to select a subset of the avdable f i e b  for listing. The user may alsa specify 

the width of particular fields. Usage is shown in E'igute 27 and a sample output is shown in Figure 2.8. 

The 'width' fields are specified in m - s t y l e  measures including units (e.g., '0.5in'). The mf' option 

produces a c m  refërence column and the 'fiow'suf~ption causes the cross reference to be colour mded to 

indicate direction of Bow. 

- - -  

Figure 2.7: Uange of formatDD.pl. 



IIL.IR>U 
L m e  
LLKOF 

iiLPHDb 

W H R E  

MEABF 
MEAD2 
BALPHA 

BKFRAR 

BUFRAR 

EALPHA 

MWNA 

FALPHA 

- 

afph k tn u d  ht f  aif ioc 

n k  nte from alpha n d î o w s  

a m  d aie bKLnll 
a m  of Lhe damacd zone 
Fit e t  b fa alpha ndi-s 

m3e Gnsrr6td alpha dooc as a 
fundon of tirnt a(t). 
d u a  of alpha d o r t  tate ta the 
~iT-aÿord fucl 
relu= rate fmm wai fuel ptr 
ananier fm alpha tadiab-s 
am d ai t  bcldill 
am d the dama@ zone 
Ernpirïal fît ocni&nt 'K for 
alpha ndiotyris. u d  in the ai- 
ailarian d o f  the dqradamn 
ntr per unitsuriauaru d fuel 
Eo (1) = 14, (t + WP I* 
lnaian a fnu i t  a m  cpntaining 
baddiu 
fnaion o f  n u l t  a r a  cantaining 
M r  
BaW on olgmmental data ci.- 
reiatina alpha d a u  rn rate d 
fuci &on. Uad ta estimate 
the standard deviation of pt 

di& c ~ r ~ o n  r a b  
hic ta bg of pndiatd cwro- 
mon dutm rlpka dane as r func- 
rion cf tirnt 
Mtan aperimenul alpha tadi 
awf 

I 

iPMPH 

PALPH 

;PALPH 

VARLK 

YARtVG 

SPALPH 

SPALPH 

- - 

a r p n o c  

ALPI-Oc 

VLGOEP 
VLGDEP 
ALPHDS 

VLCDEP 
VL-OEP 
VLCDEP 
VL'OEP 
ACPHDC 

ALPHDS 

JLP+t[lS 

Figure 1.8: Portion OF a Da& Dictbnary üattng. including a cmm mfsrenca column. 
input and output data Bowa are colour codai p m n  ~d md. respecttvaiy. Local varlablea are bladc 

2 2 4  Equations 

Equations are heId in individual files. with version information simiiar to other mec components. These 

files cm be inserted into WQX documents using the \input() rnacro. A siight modification to the usual 

=ec file format stores P p e c  information in comments, as shown in Figure 2.9. 

It hes pmved convenient to generate these files using a PC/Macintmh pmduct d e d  MathType, w b c h  

adds additional commenta to the file, oontaining encoded idormation w M  alIows the quation to be 



used in P G W  word processots, 

as weU es Hi)#, as shown in Fig- 

ure 2.9. The comrnents generated 

by M a t h m  are ignored by w, 
but can be importeci back onto the 

persona1 cornputer for inclusion in 

word processing documents. This 

decreases the poesibity of inconsis- 

tency between Wpec documenta- 

tion products and related technical 

reports, memoranda, etc- that ref- 

erence the same eqimtions. 

Although the use of MathType is 

optional, many users prefer the use 

of a graphicd equation editor over 

ASCII input of math syn- 

tax. Figure 2.9 illustrates the use 

of the graphical editor and shows 

the ASCII equident. Other graph- 
ical editors are available, including Figure 2.9: AIL exunpie Equation Rle, ahown in ASCII format (top) and - 

bain& edited by MnthT'pe (bottom) 
m d e ,  which is available without 

charge h m  the manufecturers of MathType (but Iacks the word processor interface). 

3 e  syntax for the Equation fiie is as biiows: 

Syntaz of Equation (.tepl jiie 

%Name: ~5hor-t name in ascü f m t  - minimol f i  unique identifieotiona 
%LongName: ~descriptiue nnme in ascii format - up to a sentence<l 
Wenion: lzuersion numbw for truckhg hiatory - appears on listingsu 
WProject: ~pruject  identifimtiona 
%Subproject: mub-project identibt iona 
%uthoc oauthor's fui1 namea 
9% Date:  date that the n t r y  was unittena 
%piementer ~ f u i l  name of person who input tfiia enty k t o  the @ma 
"JoimplementDate:  dut te thut the entry WM e n t d  into TeX~peca 
%Reviewet: +jüll name of m - e w e w  
CPoReviewDate: +date of rnkw 
%Descnptian: ~jül ldesrr ip t ion-uptoapamgraph~ 
+comme& M a t h l f r p ~  



2.3 Application Composite Componenu 

Some 'I)$bpec input tiles are directly associated with a final product. They t y p i d y  reference the shared 

components d i s c d  in Section 2.2. 

EBch of these files is the primary input for m p e c  processing as shown in Figure 2.4. Xote that Design 

Specifications act as both a primary input for designSpec.pL and a shared component for stnictureChart-pl. 

2.3.1 Data Fbw Diagram 

DFDs are stored by name, and are migned a number only when the procesing script (cifd.pl) iJ run. This 

mechBnism aiiows a project to be renumbered without n h y  changing the content of the diagram. The 

output fiom the procgsing script is named accordhg to the specifïed nurnber, which is then processed by 

B ' .  This naming convention is important for consistency checking, s d i s c d  below. 

Figure 2-10 illustrates this proces. The diagram 'D iagm-  

Nome' is asiguecl number 1.23, which is represented as '123' 

in fiie names. Consistency checkuig is perforrned against the 

parent Data Flow Diagram (DFD 1.2) as descnbed below. 

Syn ta~  for processes (often caIIed 'bubbles' when speaking of 

Data Flow Diagrams) and data stores are described by Your- 

don [30]. Of particder importance is the distinction between 

'atomic' processes (i.e., processes which have an associated Pro- 

ce s  Specification), which are shown with double circIes, and 

w 

1 

processes with lower Ievel DFDs (i.e., processes associated with FI- 3.10: ~a taaow ~ i -  pmcauing, 

child DFDs which decompose the process huther) which are n p e c i e t h e  di- marnber (ls2s3) 

tirne. 
shown with a single cide. 



The syntax for the DFD file is as foiiows: 

Syntaz of Data FIOW h g n r m  (.dfd) file 

Name: ~ s h o r î  name i n  oscii format - minmiai for unique ident i&at ion~ 
Version: oversian nutnber for tmcking hàstory - appenrs on IistMgsa 
Project: ~ ~ e c t  idenlificution~ 
Subproject: ~mb-pmject i h t i & a t i t m ~  
Author: oauthor's full namea 
Date: [>date that the enhy w u  writtena 
Implementer: DW~ n m e  ofperson who input this entry into the syatema 
ImplementDate:  dut te that the entry wos e n t d  into TeXspeca 
Reviewer: +j%l nome of remremmer* 
ReviewDate: +date of mi eu^ 
Unitx +u&d Bw un& of meam* 
Labels: D 'maüa '? 'aliort ', 'med ', or 'long h 
 proce ce rie specld 

1 [datastore spec] 5 
o[flow specjo 
t @egend spec] < 

Notes: tannotation ~ s ~ a t e d  with the diagmm+ 

Where: 

Process D#4: ~ d f d  ot mini-spec name 
(name may incl& j\ ' = fine b& for labeling)~ 

At: ~ z , y  d i n a t e s  in qmified unitsa 
atomic +&g to i n d i d e  that pmcess iP a mini-spec* 

( connecter spec = 

Connectar: ~ f a b e i  for off-page mnectoKI 1 At: DZJJ uundinates ni wjied unitsa 

1 datastore spec = 

Datastore: d lob el for data bma 1 At: D Z , ~  d n o t e s  m qmised unitsa 

Flow: oenlry in Repiilrwnents Data Dict ionary~ 
h m :  ~proass ,  mnector, or data storea 
To: ~procws,  connectw, or  data storea 
Type: +'staticr or Yernpomi4 
Infiection: + d u r e  of ammi+ 
RelPm: +position af labei along the cunre (0'1 ote the en&)< 
LabeIOfkt: t o rse t  of &abel mwy from the cume (99 = do not fabel)< 

Legend: D 'uertjdr or 'horùontaih 
At: D ~ I J  d n a t e s  in specr3ed unitsa 



Connectors are pIaced at the ends of arrows representing flows that terminate outside the curent diagram. 

Processes, data stores and connectors are aii Iocated ori the ditrgram by specifying @,y) coordinates, in units 

selected by the user. 

The specified positions are relative, but the scde is absoIute. The origin will be located so that negative 

values wiü not be placed off the page. Distances between objects that are larger than the available drawing 

area causes the diagram to be truncated; no scaling is pecformed, 

Flows are specified by stating the end points (processes, data stores, or connectors), the infiection of the 

c m  and label location, The meaning of the values for curve infiection and Iabel location are defined by the 

xypic [23] package. The idection is specitied as the o&t fiom ünear at the midpoint of the curve, in the 

same unita as the rest of the diegram, with positive values bendihg up and to the left and negative values 

bending down and to the right. Label location is specified relative to the fiow, with O king the start of the 

fiow and 1 beiig the end of the fiow, but values less than O or greater than L are permitted. Label o&t 

values phce the label the specified distance h m  the c m ,  with positive vaiues being above the c m  and 

negative onSeta being below the curve. 

Figure 2.i.i: Example DPD file. 

Not di Barn  are s h m .  Note the uae of the \\ to denote a &ne break in the 'Procesa' m e s .  

The 'Notes' are rupplemented by pnerated notes h m  m e c ,  M s h  in Figure 1J1. 



An example of a DE1) nle is shown in F i  2.11, and the output gensrated by Q?Lpec and W&X is shown 

in Fguie 2.12. A complete example is containeci in Appendix A. 

Impkmaited by SPCGC 

Plgure 1.12: Example Data Flow Diagram. 

'Notas' M genemted ta deuil the content8 of aqy composite iiow whae contenta appear on the 

d m .  The componentr uhldi appenr on the diagr- ue a h m  in boid type. 

supports two types of Bows: 'static' (not tirne dependent) and 'temporal' (tirne dependent)- This 

contrasts with the Yourdon [30I specification, which supports 'datar and 'contro17 flows, Bath 'static' and 

'temporai' Bows would be considered 'datar Rows by Yourdon. The visuai presentation of two distinct types 

of Bow is similar and ody a generated iegend (which is optional) wouId betray the user who redenned the 

two ï$Jbpec Bow types for the purposes specined by Yourdan, In the future, î&Xspec may be enhanceri to 

---+ + + L : J  O-*-lt\ II-. - -Z --LI- I- -~G+L..u n..mZIPv nf i3- h t ~ ~  -p., u i.-u \ -...lu., ..W.. .,- ... p...- UU ...Y.U...~ Y- - UI -a 7 



Consistency between DFDs is monitored by '&Xipec. As shown in Figure 2.10, at run time dfd-pl accepts 

an input panuneter to d e h e  the diagram number. Generated output is tagged with the diagram number, 

by including the number in the name of the file containing the generated output. The script Iooks for output 

h m  the parent of the assigneci diagram number by searching for the file name containing the parent's 

diagram number. If output h m  the parent diagram does not exkt, then a warning message is generated. II 

a parent diagram does ex&, then consistency is checked, allowing for composite Bows. The input and output 

flows on the curent diagram m u t  correspond to the Bows to/from the appropriately numbered Process on 

the parent diagram and ai1 Bows belonging to that Pmcess m u t  be reprwnted on the child diagram. This 

can be either an exact match. or Bows on the child diagram may be contained in composite Bows on the 

parent. 

Parent DFD 1.4.3 
Child DFD 1 A3.2 

Sm 

Figure 2.13: Combtency Checkhg of DFDs. 

Parent DFD 1.4.3 is s h o w  on the leR and it's only child (DFD 1.433) t shown on the right, The highlighted 

fiel& illutrata consistent u w  of a axnpoaite fiow - no highltghting appearn on nctunt output. 

Figure 2.13 illustrates consisteng checking. The parent diagram (DFD 16.3. on the le&) contains three 

Processes, Proces 1 and Process 3 a e  represented by double üned circIes. indicating that they are 'atomic7 

and are detaîied in an equivalently numbered Process Specification. Proces 2 is reprrsented by a single lined 

cucle, indicating that a chiId diagram ( D a  1.4.3.2) exists. mi shown on the right. 

To illustrate the treatment of composite Bows. 'spmicn' is highiîghted in mi and it's components are hi&- 

Iighted in p n .  The chiId d&pm (ou the right) shows inputs of 'CFTûT', 'CPTOT and "L'CAR', which is 

consistent wîth Bow 'spmicn' ïnto Proces 2 on the parent diagnun, Detaii of the decomposition is contained 
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in the 'Notes' section on the child Diagram, Note that 'spmicn' is itself a component of flow 'spion', which 

would appear on the grandpsrent diagram (DFD 1.4). 

2.3.2 Pmcerr Specihtions (Mini-Specs) 

Process Specifications are stored by name and are assigned a number only when the procesaing script (min& 

pec.pl) is m. This mechanisrn ailows a project to be mnumbered without necessarily cbanghg the content 

of the specifications. 

input and output Baws are specified m Requirernents Data Dictionary entries. if the parent Data Flow 

Diagnun (Section 2.3.1) hw been processed, then the flows are veriûed for conaistency, otherwise a warning 

message indicates that no vedication wes performed. Flows in the Process Specification must be atomic, 

but the corresponding Bow on the Data Flow Diagram may be composite (although this is diiuraged). 

Otherwise, consiatency checking is analogous to checking between a Data Flow Diagram and it's parent. 

The detail of the pmcess is specified in free form idQX. No consistency checking is performed between this 

and the specilïed flows. A macm is provided to d o w  the user to include a 'PEXspec equation. The macro 

includeEquation{name) causes m p e c  to scan the search list for name.teq and insert the contents at the 

specified position. 

The syntax for the Procens Specification file is as follows: 

- - -  

Proces:  short name in cucii format - minimd fin- unique identaficotiona 
Version: DU-on number fw trricking h w t g l  - appmrs on l istnigs~ 
Project: ~ ~ e c t  identifiaaliona 
Subpro ject: mufi-pmjecî identifications 
Author: ~oul l ior '~  PL name4 
Date: odde  fhat hie en@ was w i t t m ~  
Implementer: DJWL name of person who input th& entry into the systmQ 
ImplementDate: ~ d d e  W the dry was entered into TeXspeca 
Reviewer: +)%il name of 6ewer< 
EkviewDate: +date of r m i ~  
\ begin{description) 

An example of a Prooess Spincation me is üsted in Figure 2.14, with the correspondhg specilïcation tu 

generated by and KQ$€ 



Figure tJ4: Example Specificatlon. 

The input Ble on the Ieft ranilted in the rpedecation on the r i e  



2.3.3 Design Specifications 

Module design documentation adheres to the concept of Iiterate pmg,78mming [IO, 121, which uses a single 

source file to generate bath the Design SpeciEcatioo and compüable code (the same file is also referenced to 

assure consistency with Structure C h m .  as discussed in Section 2.3.4). 

The syntax follows a hybrid format. with TeXspec specific syntax providing an interface with the rest of the 

system. This component is processed by TeXspec to produce a Nooweb [211 input tile, which is then processed 

into finai products. 

Noweb is a literate programming cool that p w t s  a madde to be broken d o m  into code chunks which 

con& of blocks of M&X commentary and mrresponding compiiable code. Tt has a simple syntax that is 

portable to most programming Languages, incIuding Fortran. 

Noweb code ch& that are not referenced in other chunks are placed in the defauit code chunk << >>. 
The description, declmation, "include". and directive chunks are generated automaticaily by m p e c .  

Although the generated code is not intended to be a main- 

tained pmduct. the description is replicated (as comments) in 

the generated code, The code 'chunks' are aIso commented. 

by practice, to allow easy navigation when using a symbolïc 

debugger. 

Aiso carried through to the code ore the variable definitions 

from the Design Data Dictionary, These dennitions are placed 

next to the =-able declarations. This includes the *Physical 

Units' assigned to each variable and allows the use of AECL's 

unit checking program 'UNITCK' on the generated Fortran 

code. WITCK is a proprietary static analysis tool that bal- 

ances physical units in each executable Fortran statement. 

The actuai processing of a Design SpeciEcation occurç in 

stages, as shown in F i i  2.15. The procesaes performed by 

modulads 

A DeiÏgn Specifïcation file is processed by -designSpec.pl' to produce a Noweb (211 input file- Noweb's two 

constituent prognuns aoweave' and aotangie' independently proeesg this iïie to produce a &&jc input file 

containing the formatted specincation (sx F i  2-17}. and an ASCII file containing the compiiabIe code. 



Noweb output contains declarations in 'code chunks' which would be printed in the @cation. '&&pet 

prints a superset of this information in tabular format, so the 'cleantexpl' PEFU script removes the redundant 

code chunks before generating the Design Specification, without impacting the generated code. 

The code output by Noweb contains, by default, many b l d  lines which make it dificuit to use a symbolic 

debugger. The PERt 'cleanfortran.pl' is used to remove the extraneous blank Iines. 

Further reformatting of the code is up to the user. For example, it is possible to pass the Fortran t h u g h  

CERNs Floppy [2] package to reformat the cade and produce a rudimentary static anaiysis- Most processulg 

that users wodd perform on manually generated code can be applied to the generateà code. 

When reviaing and debugging code, it may be advantageous to eliminate the overhead of generating the 

documentation as shown on the left branch of Figure 2-15 (starting at 'noweave') until the code is stable, 

Design Spdcat ions are checked for internal consistency between declared variables and the Fortran code. 

S i  information in the Design Data Dictionacy is not repeated, but is extracted and pIaced in the Design 

Specifications (and hence the code), these products cannot be inconsistent with the Data Dictionrtry. 

Information that appears in both the Design Specifications and the Stmcture Charta (Section 2.3.4) is aIso 

not repeated. The Design Specification acts as the repi tory of the shared information t h t  the Structure 

Charts reference so they cannot be inconsistent. 

Similady, uaen are encouraged to share equations in a common pool (see Section 2.2.4). Although there 

is no requirement to do so. it is helpfd to keep notation consistent and to propagate changes through alI 

aareeted products. 

Since bath the code and the formatteci specification are pmduced h m  the same lile, Tj$@ec(through 

Noweb), a c q h  the attributes of literate pmg-J [IO, 121 systems, including consistency of the spec- 

%cation and the code. Correct code documented with an inconsistent Design Specification can result in 

many software defects [18], which cannot occur with literate pmgraxnming techniques. 

Arguments and shared variables must have a declarecf direction of Bow: 'input', boutput' or binputioutput'. 

This information is refiected in tabular listings in the specification (the table for caii arguments is similar to 

the table for shared variables shown in Figure 2.17). It is 8190 used in the generation of Structure Charts 

(Section 2.3.4). 

#en the design specification is processeci by l$jbpc, the Fortran code itseIf is examined for internal 

consistency with the declared variables, incIuding d i i î o n  of Bow. The use of undecIared variables is 

Bagged, JM is the deciaration of variables that are not used. '@Gpec issues a wcuning message if -ables 

designrit4 as 'output' fiows are never the snbject of a Fortran assignment skitement, or if 'input' variables 

are changeci. It Ïs critical to have 'input' and 'output' correctIy tagged, to ensure a correct Structure Chart 

( s e  Section 2.3.4), Dictionary Listings (see Section 22.3) and Design Specincatioa 



The syntax for the Des@ Specifiation file is as foiiom: 

Syntaz of Design Specijication (.d$ füe 

Module: 
LongName: 
Version: 
Project: 
Subproject: 
Author: 
Date: 
Implernenter: 
ImplernentDate: 
Reviewec 
ReviewDate: 
Language: 
Standard: 
<<description>>= 

Dmodule name ni as& f i t a  
+descrïptiue nome in ~ c i i  fonnat for Structure Chart< 
puersion number foi- trucking history - appears on listingsa 
( > p e t  identifiatirno 
~mb-pmject identifiuition~ 
Dauthm 's fdl name4 
 date Uiat the mtry wittena 
DJU nome of person who input th& entry mto the systema 
D&e that the m t q  wm entered mto TeYspec4 
+jdl  nome of méwer< 
*date of m r i ~  
D 'Fwlm-73, ' 'PROGRAM' m 'SUBROUTINE' OT 'FUNCTION'a 
~applicnble progmmrning standorria 

Argument: DuaRa6Ie in Design Data Didionmy~ 
Flow: D Sn@' or 'output' or inpiir,output7~ 
Dimension: ~Dimcnsi4n b mernile &finitiun in Deaïgn Data Didionary~ 
+ Iprepost] 4 

Local: 
Dimension: 
Data- 

~ u m i n b k  in Design Data Dictionarya 
r>l)immsim to uuememde definition in DmMgn Data D i c t i o n a ~  
p initiai value4 
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The example module in Figure 2.16 has no arguments. Argument flows are p l 4  in the flow List in the 

order that they occur in the argument List. By convention these ffm would be declarecl before any shared 

or local variables to make this order clear. 

Arguments and shared may o p t i o d y  speciry a precondition and/or a postcondition, depending 

on the direction of flow. If the variable ~ R S  a 'Condition' in the Design Data Dictionary, then that condition 

is taken to be a precondition andfor postcondition, as appropriate. Explicitiy stateti preconditions and 

postconditions in the Design Specification file are added to anything mntained in the Design Data Dictionary. 

For example, the variable BKFRAR is declared in Figure 2-16 without a precondition, but the precondition 

O <_ BKFRAR 5 1 is extracted h m  the Design Data Dictionery and appears below the table of shnred 

variables. 

Preconditions and postconditions for arguments and sbsred variables can optionally be accumulated together 

in the specification, but aRer some experimentation, the default beheviour has been set to place the conditions 

sepanrtely, be!ow the appropriate table. This generates a longer specification, but keeps associated elements 

at close pmximity, which makes the specification easier to read, In some cases (perhaps code which involves 

Fm variables), the accumulated format may be preferred, so the option to ovenide the default behaviour 

remains* 

Tables are formatted dynamically, so that no blank colurnns are produœd. If no mathematicai symbols ex& 

for any variable in a table, then that table will not contain the 'Symbol' column, 

The tirat major heading in the Design Specification is 'Module Companents', which identifies the Noweb code 

chunks that comprise the default code chunk << + >>. This section is generated by T)@jpx to include any 

chunks specsed in the Design Specification file (wM& are not referenced by other code chunks), plus chunks 

generated by QXspec. The generated chunks correspond ta the sections of the document, but the order in 

the Design Specification is different h m  the order in <c s >>, which specSes a compilable sequence. 

For example, the cc include >> code chu& is generated and piaced before any executable code chunks 

in << * >>, but is detaiied near the end of the D&gn Specilïcation- This is because few ceaders wish 

to use this section, yet it can become quite large. Any dectared variabies whme Design Data Dictionary 

entry specSes a 'Fie' causes the iiie to be included in the CC indude >> code chunk ('INCLUDE' Hes 

in Fortran). This relieves the user h m  the burden of =mbling the correct header Mes, as the job is 

performed automaticaiiy. 





Ody one table of miables is shown in Figure 2.17). There are no arguments to the example module and the 

table of I d  variables is not shown to conserve space in the figure. The table of locai varîables is similar, 

but does not have a column for the direction of Bow ('I/O1). It wouId, however, have a coiumn a l  values if 

any local variables were asaigned a constant 'Value' in the Design Data Dictionary. 

' h o  executable code chunks, '<< main >>' and '<< darcyCumpunmts >>' are shawn in Figures 2.16 

and 2.17. There are several other chunks, but they are not shown. The 'Module Components' section of the 

specification specifies the content of the default code chunk '<< * >>'. Note that this references a nurnber 

of generated code chunks and the input code chunk '<< main >>', but not '<< darcyCmponents >>'. 

T@spec places aii input code chunks that do not appear in other code ch& into '<< >>' in the order 

that they occur in the =gn Specificatîon file. Code chunks that are referenced by other code thunks. such 

as '<< darcyComponents >>', which is referenced by '<< min >>', are not pIaced in '<< * >>'. 

The description of the '<< darcyComponents >>' code chunk iiiustretes the use of methematicai notation 

to cIarify the specification. Some of this notation is input locally, and some is extracted from shared equations 

in .teq Mes via the \indudeEquation{) macro, which causes Wpec to scan the se.srch Iist for name-teq 

and insert the contents at the specified posîtion. 

Stmcture Charts lorm the high Ievel system design abstraction. They are similar to the format specified by 

PageJones [191, but include some additionai information and use coIour wding, rather thau symboh and 

arrows, to specify the direction of data Bow, 

Structure Charts memble Design Spetifications in a manner roughly anaiagous to Data Flow Diegnuns 

agsembling Mii-specs. One difference is that Stmcture Charts are not iayered, so each Module is 'atomicr 

and is not decompd .  The result is that a Structure Chart can be very large. so support is provided for off- 

page connectors which aUow the user to break a Structure Chart into sections that can be sized convienently 

for publication. if multiple Stmaure Chat  sections are connecteci with otf-page connectors, then 

verifies consistency between tbem using a method simirar to that used for Data Flow DiagramS. For each 

off-page connecter, ïJ$bpx searches for a previously processeci Structure Chrut wit6 the same name- if 

such a Structure Chart is found, then the conneetion is vaiïdated, otherwise a warning message is generated. 

Options supporteci by m e c  specificaüy for Fortran-ïï dispiay the status of 'COMMON' variables within 

each moduIe, as well ss in the argument Iist. 



The syntax for the Structure Chart file is es foiiours: 

Fynta2 of Structure Chart (.SC) file 

%rt: Dchart name in ascii 
LongName: ~descriptiue name in asaï format f m  Stnichrre Charta 
Version: Duersion number for trocking h 3 t q  - appears on listingsu 
Project: ~ p q ' e c t  identijication~ 
3ubproject: ~suCpq*ec t  identifimtiona 
Lut hoc  aut th or's full nameQ 
Date:  date that the entry was witten<I 
[mplementer. ~ f i r l l  name of person who input this entry into the systema 
ImpIementDate:  date that the entry was entered into T'speca 
Reviewer: +JW name of reviauew 
ReviewDate: +date of mfWIw 

Unitci: +valid Bw unüs of mensunz+ 
LabeIs: ~'ùntg'nnazirnum &th and/or 'sharedra 
Entry Point: +%,y d i n a t e s  in specrjki uni&< 
SubmodeIColour: ksubmodel name:wlmr code (defauit fm submodel)< 
? [aubmodeicolour] 5 

module = 

Module:  design Speciftcationa 
At: ~ z , y  d i n a t e s  in specrjied unitsa 
Background: +colour d e i  
Ception: + m e r d e  of module long name< 
CaüString: +z, ynncrzimum lmgth* 
[ d l  

Cdl:  module m off-pge umnectm that appeon on this charta 
Vur: kz,y point on connecting lin& 

offpage = 

Offpage: pname of chifd Stmdure Charta 
At: p q y  coordinates in sjtecified unitsu 

An example of a Structure Chart fie is shown in F*igure 2.18, and portions of the output generated by 

ï&m and is shown in Figure 2.19. 

Mu& of the information on a Structure Chart is extracted Fimm the referenced Design Specitïcations. The 

cal1 interfece, including the argument S i  and direction of data îlow is extracted from each ceferend Design 

Specificatioa and piaœd abave the module- if h6els:shad is spffined then any Fortran COhlMON blocks 

are sh- in dphabetical order, with referenced colour coded by direction of data Bow. 

'Qjhpm performs some consistency checking between the source code containeci in the Design Specincations 

and the Structure Chart. if the refanced (caiied) modules do not agreef '&$spec issues a warning mesage 



that extra or extraneous calIs are shown on the chart. 

If k6els: h g  is specified, then the 'Long Name' in each Design Specification is placed with the module, 

as shown in Figures 2.18 and 2.19. If these names are toa long, the boxes becorne excessively wide and the 

user can then specify CabeLrr 1ong:lm to specify a maximum width More a h e  break is used. Likewise, the 

CallStrkg: &en syntax ailows an interface string to be broken over multiple iines. 

C h a r t :  S n n u  
LongNam: Invmtory o f  ALI N u c l i d e s  
V u s i o n  : 01A 
Pro jrct: CC4 
Submadrl: -OC 
Author : S, O l i v a r  
Datm : ümcamber 1 7 ,  2 0 0 0  
f m p l a a u i t u :  S. O l i v o r  
Implari.ntDatm: Dacrmbar 17, 2 0 0 0  

Uni-: inchos 
Labels : long, shatd 

Modula : 
At:  
W l  : 
V i a :  
V i a :  
W l  : 
V i a :  
V i a  : 
C a l l  : 
V i a :  
V i a  : 
Cal1 : 
V i a :  
via: 

Module : 
At: 
CallString: 

Muiule : 
At: 
Call : 
Background: 

Moàule : 
At: 
Bickground: 

bWuL0 : 
At: 
C a l l S t r i n g :  

Modulr : 
At: 
ca l1  : 
mckground: 

OffPa-: 
At: 

REPETIN 
1 . 7 5 , 2 . 2 5  
INVTRY 
y a l l o w  

INVTRY 
1 - 7 5 , l . S  

Ftgure 2.18: Examplet Structura C b  me. 



Figure 2.18: Example Structum Chnrt. Input and output data 0ows are colour wded green and 

rad, respectively. iNVTRY ia an off-- coanector. 

2.3.5 Manuals 

For the moat part, manuais are simply BI)$C documents, î&Xspec simpIy defines the F t a x  of the equation 

(Section 2.2.4) ûies to be inseaed with the \Mput{) mam. 

M h e r  support for manuais will be provideci once a configuration management system is incorporateci into 

Qmec-  

Also. the CSA standard [4[ demands a number of specific documents, and templates wiii be pmvided. 
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3 Graphical User Interface 

To apsist in the operation of the "Q%pec system, a GUI is provided, making the application much more 

intuitive to operate. 

For the purpose of this practicum, the intention was to implement aLsimple but effective' GUI. Unfortunately, 

these objectives are not aiways consistent and the program now comprises over 32,000 lines of source code 

in 85 moduIes. This compares to 8,000 Iines of PERL code in 8 scripts to implement the core W e c  

technology, At this writing, the GUI is in regdar use. and has proven to be fairly robust. 

3.1 Architecture 

The GUI fits into the ïJ$spec architecture as shown in Figure 2.1. It is implemented as a Java application. 

Tt manipulates the input files, executes the PERC scripts, and handles the output. 

The application is distributed as a Java archive ( JAR)  file and is iuitinted by a Java runtime environment. 

h m  a command lime, t h i  often looks like: 

java -jar TeXepecCUI 

The initiai presentation is as shown in Figure 3.1. The 

user must identify himself and declare a default project 

on which he will be working. 

'Che options presented on the 'login' xreen indicate the 

future development path of the pmduct. At the mc+ 

ment, the options (user identification, pmject, and sub 

pmject) are 'hard coded' into the application and the 

'Password' field door not process input- These fields 

will have meaning when the application is divided into 

client and s e m r  portions (Section 2.1.1) Pi- 3.1: mpec GUI Initiai Screen. 

The GUI is based on components provided with Java and two additionai libraries; 

r 'regexp': reg& expression parser from The Ree Software Foundation (FSF') 

r -format7: Hennk Bengtmn's printf p h g e  (for uon-commercial use). 



"QXspec components tend to be small and heId in many tiles. Repeatediy opening a large number of files 

tends to inhibit performance on many systems. so the GUI bs an abstract class TeXspecComponentr 

which establishes and maintains an inventory (cache) 

of components that have already been parsed. A back- 

ground pmcess periodically scans the search list direc- 

tories (Section 2.1.2) for files that have been updated 

since they were Iast parsed and pIaced in inventory. 

The number of windows generated by the GUI can be 

Iarge. -4 desktop window is used to contain these win- 

dows, which amid9 cluttering the user's main desktop 

with mnay 'i$J@x windows and icons. The doiktop 

Fi- 9.3: 'LEKi- Gui  W k t o p  m n .  The bar window also provides a conwnient pIace for a progress 
dong the battom I. a 'prograu bu' and msii.pa awa, 

bar. as shown in Figure 3.2. 

3.2 Configuration and the S d  L i  

Sice  the CUI is used to create and edit Wpec mmponents, as well as process them, the search-list has 

an additiond role to play beyond the base Fun~tionaiity~ T L  nrst directory (for each file type) defines 

the directory in which output will be written. No output is written to directories Iower in the search-list. 

aithough they can be deleted- If a component is accessed From a tower directory, then edited and saved, the 

edited copy wilI be written to the iïrst dïrectory in the search-List, By placing a working directory at the top 

of the list for each me type, the user can collect his working tiles as they are modified and move them to the 

appropriate directories once the products are known to be satisfirctory. 

The Search List (Section 2.1.2) can contain a large Im 

of directories to be d e d .  This wodd be oner- 

ous to regmerate each time the GUI is invoked To 

avoid this, the GUI dows the user to I d  a 'Configu- 

ration' (which may in the mure contain more than 

the search list). This alIows the user to work on 

muItipIe pmjects without having to manipulate the 

search üst on every invocation. To load a 

tion, use Options->Load Configuration to brhg up 

the chooser window, as shom in F ' i i  3.3. Figare 3.3: Cho- to r lect  a file containhg a 

rerrdc lk  



initïaiiy, however, a search iist muat be b d t  beiore it 

can he saved and suhsequently rehaded. To manipu- 

late the List of directories, use Options->Search Liat 

to bring up the wuch list editing window, as  shown 

in F i  3.4. A dropdown menu allows the user to 

select a tile type and directories caa be added (via a 

popup chower) or deleted using the d i t  buttons. The 

'Up' and 'Down' buttons dIow the order in which the 
Fi- 3.4: Wiadow tn d i t  a search-lht. 

directories are searched to be maoipuiated. When the 

List is complete, use Optionr->Save Configuration As. . to Save the search kt. 

3.3 Requiments Data Dictiinary 

Requirements Data Dictionary entriea define fiows or mmponents of Rows which occm on DFDs (Sec- 

tion 1.2.1). 

They can be accessed by the foliowing methods, lrom the File  menu: 

File->Km->Raquirmmta-Data Dictionaq btry 

to mate a new Data Dictionary entry. 

FzLe->@m->-quirementa->Data Dictionary Entry 

to edit an existing Data Dictionary entry (or create simiiar ones). 

0 File->List->Fiequiremnt 8->Data Dictionary Entrp 

to see a List of existing Data Dictiomuy entries, or generate a formatted listing. suitable for printing 

(Section 3.5). 

The File->List method dm the dictionary to be accessed h m  an aiphabetid king. m e r  scaaning 

the search List for the appropriate 6les. a window, as shown in Figure 3.5, displays the candidate entries. 

By defadt, these are in aiphabetid order, but an option d o w  the entries to be soaed by project. The 

'Refresh' button causes the seacch-Iist to be scanneci for changed entries. 

Multiple entries can be seIected for '!?ditf or 'Delete: by holding down the 'shiftr or 'contmIr buttons whiie 

selecting with the mouse- Editing is initiated with either the 'Edit' button or a mouse doubIe-click- 

The 'Generate Listing& button activates the Dictionary Listing window, s shown in Section 3.5. 

Keeping a dictionary Ming on hand is a usehi method of aniiding Iogicdy duplicare entries. ScannIng the 
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'Long Name' column can quickly identify any existing definitions that might be used instead of a new entry. 

Since the listing is genecated from files 

and the time stamp on each file is 

checked before the Listing is diilayed, 

the dictionary Listing can be sIow to 

generate, particularly if a long search 

li is employed. It is d y  a good 

pcactice to request a dictionary rit- 

ing when the GUI is started and to 

keep the window for reference (per- 

haps shnink to an icon). 

Having arrïved at the 'Edit' window. 

via one of the mechmisms outlined 

above, as shown in Figure 3.6, fields 
Figure 3.6: List OC &quimm~nts Data Dictionary entrier. 

are analogous to the Requirements Data Diction~ry (xdd) He (Section 2.2.1). Xote the support for compos 

ite entries: the 'Add' button brings up the fui1 Iist of avaiIable Requirements Data Dictionary entries, from 

Figure 3.6: Edit a Requframents Data Dletionary entry. 
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which the dekred components can be selected- 

The 'New' button brïngs up an empty Re- 

quirements Data Dictionary entry, which can 

be Eiüed in and, when saved, becomes incor- 

porated into the curent entry. SimiIarly, the 

'Edit' button a n  be used to edit a child entry 

(if there is one). 

Changing the 'Narne' and swing creates a new 

Requirements Data Dictionary entry. This is 

a quick method to create several similar Eb 

quirements Data Dictionary entries. 

The 'Math Name' field is intended to have 

a preview button, to aiiow for the fact that 

equations oRen require more than one 

attempt to achieve a correctly formatted r* 

sult. ThLg has not yet been implemented. 



3.4 Design Data Dictionary 

LargeIy d o g o u s  to the Requirements Data Dictie 

nary, the Design Data Dictionary entries are referenced 

in much the same manner, but the editing wuidow is 

slightly larger to handle the increesed number of fields 

(deEned in Section 2.2.2). Recall that the Design Data 

Dictionary entry may be mapped to a Requirements 

Data Dictionary entry, which can eliminate the need 

for some of these fields, Inheriting a 'Math Name' or 

'Description' can save both typing and maintenance 

effort. 

The 'Select' button brings up the fuii l i  of availabte 

Requirements Data Dictionary entries, from which the 

corresponding entry can be selected. Alternatively, the 

name can simply be Cyped in. 

3.5 Dictionary Listing 
Figura 3.7: Edit a Deiign Dah Dictioaary sntry. 

h m  the File->List window for either type of Data Dictionary entries, the 'Cenerate Listing' button 

,dow provides an interface with 'formatDD.pIT out- 

lined in Section 2.2.3, through the script file 'for- 

matDD.batr. The mechanism is outlined in Sec- 

tion 3.11- 

The dictionary listing module is very flexible (see 

Figure 2.7). and capturing al1 of that Bexïbity 

might resuIt in an unnecessarily compücatd in- 

terface. Some of the B&bity is compromised to 

achieve a more intuitive interaction. The avaiIab1e 

coIumns are easily seen and the column width can 

be adjusted, but the order of the coIumns cannot 

be controiied. ShouId experience prove that the 

order of the colurnns is important, then the design 

of this window may be reviewed. 



Pmcess Specifications are required for aii atomic p r m  w6ich oecur on DFDs (Section 2.3.2). 

'Rtey can be accessed by the following methods, Irom the File menu: 

a File->New->Re+mmts->Process Spec 

to create a new Requirements Specincatioa 

a File->Open->Re@ments->Pracess Spc 

to edit an existing Requirements Speciiication (or create similar ones). 

a File->List->Raguirements->Proce- Speca 

to see a List of existing Riquiremente Specincatio~, or generate formatted iïstings. suitable for pi inth.  

Flows on a Procesa Speciûcation are Requirements Data Dictionary entries and are shown in tabular form 

on the editing screen, as illustrateci in the leftmost window in Figure 3.9. Selecting a 'Fiow' and pushing the 

'Wt '  button causes a Requirements Data Dictionery edit windaw (Section 3.3) to come up. 

in Figure 3.9. the 'Add' button was used to bring up the List of Requirements Data Dictionary entries at 

the upper right. Selecting an entry h m  this window to lorm a new Bow caused the window on the lower 

right to prompt for the direction of the flow (the remainder of the window d o e s  the content of the selected 

Requirements Data Dictionary entry in non-editable fonn). 

FIows can be resorted accordhg to severai sort@ demes by toggling the 'Sortr button. 

Note the support for a bibüography uaing B i b w  Eriing in the bibliography fieIds wilI cause the appropriate 

BibQXcommands to be generated. 



Figure 3.9: Edit s Pmcaa Spedffcation. 

3.7 Data Fbw Diagram 

Data Flow D i a m  are high Ievel abstractions of tequirements. specifying muceptual p r o c e  and the 

flow of data between them. ïj$spec DFDs use a modi6ed Yourdon/DeMarco format traditiooally empioyed 

by the DGRTP. 

They can be accessed by the foliowing methods, fmm the File menu: 

File->Nav->Regrrirm~~~ts->Data F l o w  Diagram 

to cmte a new Data Flow Diagram. 

a File->Opea->Regttiraents->Da%a Flou Di- 

to edit an &ing Data Flow Diagram (or create similar ones). 



The fields on the Data Flow Diagram editing screen are anaiogous to those in the Data Flow Diagram file 

(Section 2.3.1). 

'Elements' on a Data Flow Diagram may be- 

atornic procesees with a corresponding Process Specilication, 

a a child Data Flow D i ,  

a a data store. or 

The f h t  two options are repmntedae cirdes (often d e d  bubbles), and are grouped together as 'Processes'. 

They are distinguished in the 'Type' column of the 'Elements' section of the d i t  wïndow, Selecting a 

process and pressing the 'Mini-spec' button will make the process 'atornic', create a Procesa Specification 

(Sections 2.3.2 and 3.6) and bring up an d i t  window as shown in E ' i i  3.9- 

'Flows' on a Data Flow Diagram are shown in tabdar fonn in the 'Flow' section of the editing screen. 

as illustrateci in Figure 3.10. The 'Content' of 'Flows' on a Data Flow Diagram are Requirements Data 

Dictionary entries. 

The edit screen shows the relationship between 'Elementa' and 'Flows' by changing the -face of the 'Flows' 

aseociated with the selected 'Elemeuts' to a bold font* Likewise, the 'Eiements' at either end of setected 

'F'iows' are shown in bold type. 

Since the number of fields aseociated with both 'Elements' and 'Flows' are fairiy small, they are p l a d  

on the edit window and no child windows are used. Valid data must appeer in the data fields before the 

'Add/Updatet buttons become active, 



Figure 3.10: Edit a Data Flow Dhgram- 

3.8 Design Specifications 

Design Specifications are ~eqilùed for aii code modules (Section 23.3). 

They can be accessed by the foIfowing methods, h m  the F i l e  menu: 



0 File->New->Desi@->Module Spec 

to create a new Design Specification. 

0 File->%a->Desi@->Module S p c  

to edit an existing Design Specification (or create s i d a r  ones). 

0 Frle->Lia->Desi@->Module Specs 

to see a list of existing Design Specificatiom, or generate formatted üstings. suitabte for printing. 

Symbols in a Design Specification are Design Data Dictionary entries, and are shown in tabular f o m  on the 

editing screen, ~s illustrateci in the leftmost window in Figure 3.1. Selecting a 'SymboI' and pushing the 

'Edit' button causes a Design Data Dictionary d i t  window (Section 3.4) to corne up. 

Note that the symbols are p-ted as two tabM tables, one for *Arguments' and the other for 'Vari- 

ables'. Data flows c m  be considerd to be aii bArguments', plus those 'Variables' that tue in s h d  s t o w e  

(COMMON blocb in Fortran). 

in Figure 3.11, the 'Add' button m used to bring up the Lht of Design Data Dictionery entries at  the 

upper right. Selecting an entry h m  this window to fonn a new Bow caused the window on the lower nght 

to prompt for the direction of the fiow (the cemainder of the window echoes the content of the selected 

Design Data Dictionary entry in non-editable h m ) -  WMe the window is labeled 'Flow', in fact it declares 

a symbol, and specifying no flow direction causes non-stiared symbols to becorne local variables. 

The 'Flow' edit window dows  the user to specify preconditions, postconditions and initialising da ta  Having 

the non-editable Design Data Dictionary 6eIds displayed in the same window helps to avoid conflicts or 

duplication. The 'Unitsr and 'Dimension' of the Design Data Dictionary entry are subject to override here. 

Note the support for a bibliugraphy using B i b w .  F i ü i i  in the bibliopphy fields will cause the appropriate 

Bib'I&Xcommands to be generatd. 

Noweb code 'Chunks' are input in commentaty-code pairs in the tabbed panes on the edit (leftmost) window. 

Pressing the 'Add' button muses a a dielog to prompt for a name and a new pair is generatd. Because 

'designspcpl' pleces Chunks into the default Chunk in the order that they occur. the Chunks are numbered 

and the 'Up'/'Down1 buttons causes the seIected Chunk to change itrs position in the sequence. 





3.9 Structure Ch- 

Structure Charts are high levet abstractions showhg the relationshipa between code moduies (Section 2.3.4). 

They can be accessed by the following methods, from the File menü: 

F i l e - > N e v - > h r r i ~ - > S t ~ C t ~ ~ ~ e  Chart 

to create a new Stmcture Chart. 

File->Open->Desip->St~ctu~ Chart 

to edit an existing Stmcture Chert (or create similar ones), 

File->List->Desip->Stmctufe Chart8 

to see a !kt of existing Structure Charts, or generate formatted listings. suitable for printing. 

the bottom edita a ningk modde on the chart- 
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3.10 Manuals and Equations 

Cunently, no support is provided for ïj$Gpec equations or manuah, but these items are present on the 

menus 89 an indication of hture deveiopment. 

3.11 Java ++ Perl Interface 

The uuderiying ï)$spec technology is implemented ai Perl scripts, but the user interface is a Java applica- 

tion, in order h r  the user to generate Q$qec produm. the Java application must intetfece with the Peri 

scripts. 

00th Perl and Java are relatively portable. but 

there is no portable interface between them 

dehed  in the Application Program interface 

(MI) of either. It is necessary, then, to define 

such an interface for 'QXspec. 

The interface could be implemented in sev- 

eral ways. It wodd be possible, for example, 

to set up an interproces communication sys- 

tem [25,26] between the GUI and a server a p  

plication which would be responsible for run- 

ning the QXspec Perl scripts. Such a server 

appiication could be implemented in Peri in 

a portabIe manner and would be a stepping 

Stone to hture î$&ec development. 

TeXspec 
GUI 

TeXspec 
script 

oîher 
processes 
(optional) 

Figure 3.13: Architsaure for rttnnhg Perl script. 

For the sake of h p ü c i t ~ ,  however, the G a  h m  the ~ a v a  CUL  ha mer a s b  for a ihtfng to be genorated - the Jan 'Runtimeaex~()' b d i o n  to ex- which initiates 'namc.bat' t4 axecute the m p e c  d p t ,  and 

optfonaiiy perforrn other functiom. mute a command, which is itseff the name of 

a script. For each PerI script 'namcpi', there exists a corresponding uiitializations script 'numcbat' wkch 

the GUI crui .exec()' to run the Perl script, as iiiustrated in Figure 3.13. 

The script name 'namebat', is seiected to make the impIementation as portable as paisible, LMSDOS prefers 

scripts with such a name, and UNIX accepts it. Although a Macintosh implementation has not been written, 

no di[ncuity is foreseen. 



The script based interface offers a further advantage. Sice 'name-bat' is t y p i d y  a short script, it can be 

customized to perform other functions in nddition to ninning the "Q$qec Perl scripts. S i c e  the 'I)$spec 

outputs are primarily EYQX files, it is convenient to nui i4QX once the 'QJGptx script has run to successfid 

completion. A viewer can then be initiated to show the product on the screen. 

This is particularly useN in the case of 'desiflpec.batr, since in this case 'QXspec produces a Noweb 61e as 

output. The script can continue processing to generate both the Design Spification and the corresponding 

code. The documentatior: can be dispiayed and the code can be further processed, including compilation. 

The sample 'da@nSpec.bat', provided with Tj#spec. executes the 'Floppy' [2] tool to reformat and provide 

a static analysis of the generated Fortran code. 

The location of the scripts to be run (both interface and h QXqec) is detined to the GUI using the same 

'search I i i '  arrangement used to locate other files. By modifying the search lit, it is possible to override the 

defauIt pmcessing with revised scripts which reflect the current project, user preferences, or the particuiar 

job at hand. 

Output h m  the procesaing of 'name-bat' is dispiayed to the GUI user. The diplay is in three sections: 

0 Output, which includes both 'standard output' and 'standard error' listings. 

r Errors, to reduce the poesibüity of error messages going unnoticed in voluminous 'standard output' 

and 

0 a button to interrupt the process or dismiss the display. 

Figure 3.14 illustrates the format of the display. 



Figure S A :  mec script belng run h m  the GUT. The 'ermrs' are any output directed to the 'standard 

erroc* output atmam- Noweb sen& mme meaaages to tffi  at-. 



4 Conclusions 

Prior to the development of 'Q$spec no CASE tooI couid be firund which couid simutaneously 

a produœ Yourdon/Demarco structured analysis documentation, 

a support scientific and mathematical notations, 

i enforœ ownenhip of components, 

permit shering of components, 

i assemble large producta from s d e r  cumponents, and 

a verify consistency between products. 

QJqec is a fuily usable tool capable of pmducing highly presentable and reliable software documentation, 

faturing robust mathematical notation. buse of components and automatic checking between products 

reduces the chance of inconsistent documentation, which hm been a major source of software defects in the 

past- 

satisfies the requirements specified in Section 21.1. 

The tool &eves the objective of ~Kering automated support to assist devetopers of technid 

software who wish to comply with the CSA N286.7 standard [41. Complianœ is expected to become a 

requirernent for Licence applications to the CNSC. 

4.1 Maintenones and Future Devebpmant 

Tt houid be noted that l$Jspec development hae been, to date. a one man show. If the product is to be 

developed in another man.net, the following skiUs are essentiai to an understanding of the t-d aspects 

of the implementation: 

Java, including Swing, 

a PERL, 

i BI)$, including the generation of 'ciass' Hes, and 

+ ??=zh 
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Fortunately, these skills are common and none is difncult to leern, with the possible exception of 

'h' files, 

The foliowing items are ansideceri priorities for tüture development: 

0 Editors could be added to the GUZ to handle equations and manuah. 

0 The parsing of the QXspec files by the GUI ïs performed by an ad-hoc implementation bami on the 

FSF reguiar expression parser "regexp'. In fect, there exists a YACCatyle parser for Java. JYACC 

could replace the current parsing. This muid make the parsing code more compact and easier to 

modify or extend 

0 Input file formats may be converted to a format which is easier to parse. For example, 'QXspec may 

be a natural Et for Extensible Markup Languge (XML). This wouid make proeesaing of multiple 

line fields easier to procesr. Cnternai ûags used to keep track of whet field is being p d  could be 

eliminated. 

0 The configuration file is named as a 'resource filer, which typicaIIy retains settings between m. The 

configuration me might be one entry in a true tesource 6le and muid be I d e d  at invocation. 

0 The GUI support €or the graphitai products (Data Flow Disgrams and Structure Ch-) could be 

based on editable graphies, or perhaps provide a 'preview' window. Ravinq to process the file to see 

the format of the output is not optimal. 

0 More types of diagrams codd be supported, includii Object Otieuted abstractions. Object Oriented 

technology €rom the ArgoUML [22! project might be rewrble for thia purpose. 

Data flow d i  codd support 'control' fiows, tur d e h d  by Yourdon/DeMarco [5, 301. This dif- 

ferentiates between flows that control the nature of the processing h m  flows containing data to be 

processed. 

0 other than Fortran-7ï could be supported. 

Some dowance for tracing between design and requirements muid be pmvided. Currently, the moat 

usefui link between requirements and design is the mathematicai specEcation of Design Data Dictionary 

entries, which may correspond to Requirements Data Dictionary entries, which allows a reader to 

associate varïabIes in Design Specifications to terms in Pr- SpeciIïcations. It wouId be advantagwus 

to aiiow a Design Specification to explicitly declare what requirement is being met. 

0 The QJ&pec system couid be divided into client and semer portions, with t-c between them over 

a network 

0 The system could allm installation of Mes into a coungutetion management system. Dependencies 

between îiies fitrouid k monitoreâ Erom t h  system, and secunty muid be eniorceci, 
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A Sample Data Flow Diagram 

Figure A.2 detaih the input required to produce the Data Flow Diagram shown in Fiire A.1. The syntax 

is discussed in Section 2.3.1, For convienence, the input ha9 been divideci into sections, delimited by a Iine 

of hashes. Note that this file would t y p i d y  be generated and maintaineci through the GUI. 

The k t  section contains the identification 

information common to al1 Q$spec comp* 

nents. 

The second section indicates that the posi- 

tions on the diagram are specified in inches, 

and that the 'Name' field in the Require- 

ments Data Dictionary entries are to be used 

to label the flows. Alternatively, the 'long' 

name or mathematicd syrnbol could be d. 

The third section specifies the procesa 'bub- 

bled to appear on the chart. Note that p m  

coiaes L and 3 are specified to be 'atomic', in- 

dicating that they are m i a t e d  with a Pm- 

c e s  Specification (Mi-spec), while process 

2 is essociated with a child diagram, 

The fourth section specifies the location of Figure A.1: SampIe Data Flow DLgram, 

off-page co~ectors. This particular diagram employs a convention plecing inputs on the Ieft and outputs 

on the right, but this is not a requirement. 

The largest section detaiis the 'Fiows' to appear on the diagram. Eech 'Flow' in the diagram is de6ned with 

a Rquirernents Data Dictionary entry similar to Figure 2.5. 

The fimi section contains notes to be placeci on the diagtam- This is often supplemented by notes generated 

by 'QXspec ta indicated the treatment of composite Requirements Data Dictionary entries. 





6 Sample Design Specification 

Figure B.3 details the input required to produœ the Design Specification shown in Figure B.1. The syntax 

is discussed in Section 2.3.3. For convienence, the input has been divided into sections, delimited by a line 

of '%' characters. 

0.1 Output 

The header containa the identification information common to al1 wpec componenta. To keep track of 

the components used to agaemble a Design Specification, or any 'QXspec product, the WQX Mes generated 

by ïj#pec contain cammentary that identines d referenced components, and the version of the QXqec 

module that assembled them. A date-the stamp is visible above the header in Figure B.l (in the upper 

1eR corner) to uniquely mociate the E Q X  tiIe with the ass0claSSOClated product. By retaining the BQX Me, it 

is possible to audit the content of any produa. Figure B.2 shows the top of the WQX Me ~saociated with 

Figure B.1. Note the matching date stamps and the Iist of components, includii version identification. 

Below the header is the defauit code chunk cc r >>. The code chunks that are represented by tables 

(<< argument >>, << Iocai >>, etc.) are generated and are not identified in << >> by obvious 

association. The Q&pec module deantezpl removes these code chunkg fmm the Design Specification, 

aince the tables contain a auperset of the information in the associateci code. Generated code chunks that 

are not represented by tables (<< interface >>. << description >>, etc.) are displayed using the usu8i 

Noweb notation. 

User wTitten code chunks, which are not referenced in other code chunks, are placed in << * >> in the order 

that they occur in the input. in this me  cc CfieckArrayBounds >>. << initialize >>. and << main >> 

are in this category. 



-- -.. -- 
Moduk ALPHM : Sirndau fud duse fiun ~ W U  d m i p  Vmxm U2.H 1 
~ ~ t i m r  S.E. o l i i  wumr 
Impimnanorr S E O l i i  U r  16. N01 
Rmnu: T.W. Wnyk M x  16. nKn 

Calling interface: 

Arguments: - Lory N a m  15ymbal UNCr [ D i m c m i a r ( O i ~ T ~ I  1/01 
CALTW ai l  <ypc 'TIMES' s'VALUES' 

W. 5 6 t NOALPH if CALlW = 'TIMEY 
urickaqd if CALTW = "VAWET 

nwss: , O cor (J..NTJ if CALTYP = -me- 
unchrnw if C A L W  - 'VALUE 

ALPIIRE: unat  6 CALTVP = T M E T  
rOfw(LNT) iFCALïYP =*VALUES 

COMIN: = TRUE 
OK: = .lm€ 



Constants (PARAMETER): 

Shared (COMMON) variables: 

CALPHA 
DALPHA 
W H A  

Sala fm for alpha dosr sabr awble 1 
a l ~ d o r i m u d h d  w h a  [Gia[ MXUOOS double I 
omi v a l u a  (or alpha dou rare :al MXUDOS double I 
FI d a m t  b fa Jdu ndidyus 1 d a r  double 1 

[I mlrr dwbli  1 
Q rcrkr dwbir 1 

( USURFA ( & i  surfau ama [m2f salir dwblr I 

AUPW*: nt 
UFCOF: > O for if CALTYP = 'TIMET 

-if C A L W  -"VALUET 
U P H M k  >O f&(l..NOALPH) f UUW = -TIMET 

mm if CAiTYP = 'VALUE9 
UPMl l :  > O  fw(L.NOALPH) if CALlW = ' T I M S  

nm if U I L W  = ' V M U W  
B A L P W  Ilt 
CALP* su 
DALPHA; r* 
€ALPHA; nt 
F A L P M  sa 
NOUPM: 1 5 NOALPH <_ MXUWS 
StDNOknt 
l t 0 0 L :  > O  
UWRFA; > O 

Local variables: 

Data: 









a... 
a... 

a... 
a... 
n... 
a... 
a... 
n. . . 
a.. . 
a... 
a.*. 
a - * -  
@... 
a... 
I... 
a... 
a.. . 
a. .. 
6. .. 
a.. . 
a. .  . 
a. .. 
a... 
a... 
a. .. 
a... 
a... 
a... 
a... 
a... 
a... **-. 
a... 
a*.. 
a.,. 
a.-. 
a... 
a... 
a... 



6.2 Input 

Figure B.3 shows the input Design Specification file used to generate Figure B.1. Other input information 

was extracted h m  the Design Data Dictionary, as indicated in Figure 8.2. Note that this Sie would typicaüy 

be generated and maintained through the GUI, 

The first section conteins the identilication information common to d mec components. 

The second section provides a description for the module to be piaced in both the code and the Design 

Specification. For the code, Fortran comment characten (a 'C' in coIumn 1) are added. 

The third Iists the arguments to the module, in the order that they are to occur in the interfece, Direction 

of data Bow must be stated. Preconditions and postconditions are optionai, and are added to any conditions 

in the Design Data Dictionary. 

The fourth section lists globai (COMMON) -ables. The order does not impact any products, but aiph* 

beticai order ia oRen easier to cead. Direction of data fiow, preconditions and postconditions are similar to 

the arguments, 

The fifth section i i i  the local variables and any initialinng data Note the variable 'MSG' lor which the 

dhnension in the Design Data Dictionary has been ovem-dden. 

The next section i i i  constants used in the module. Values are extracted lrom the Design Data Dictionary. 

The next severai sections are free form MJ$. which is pmceseed to the mmmentary associateci with the 

k t  code chunk. 

The remaining sections are the user supplied code chunks. 



Figure B A  Input muirad to produce Figure B.1 (1 of 4). 



Figure B.& Input mqulred to produce Plgum B.1 (3 ofl). 





. C " " C C  

ti r i  

- - 

B h  8.9: Input requued to producc Figura B.1 (4 0f4). 





- C L  . -  . a:!,, . * z C f  
I I -  



---  *..- * L I  

0 O 
. = - a i  :i , o r  

. n n - 3  r m r e  
I Q E  IL. I f  C.5 
- 1  :'un*o-non 

1 .C O*- 

Figure C-1: Example P E U  Module (3 o€O). 





Figure CJ: Example PERL Module (5 of 0). 





Figure CJ: W<ample PkXL Module (7 or Y). 
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Flgme Ca: Example P a  Module (8 oK ttj. 



Figure CJ: Example PERL Module (9 of 9). 



D Sample Java Module (GUI) 

Figure D.l lis& one of the smaller Java modules 'De.sisnSpacifi~tiddi&mcjava'. This k i n g  

is intendecl to iiiustrate the coding design and style used in ail such moduies- 

The '&&pec GUI contains are over 32,000 iines o ï  Java over 85 modules. 



/ / T i = l e :  TeKsoec : Des:anS~rczf z c a t s o n E d l t  
/ /Vers ion:  3 .  
/ / C a a v r i a h t :  C o ~ v r r a h t  !ci 2 
/ / A ~ i h o r :  Szeve  011- 
/ /Comoanv: U r i l v e z s ~ t v  c f  Esau: 
! / D e s c r l o t l o n :  Graohrca l  ;xcer face f o r  TeXsoêc C k ç l  

/ "  
E d i t / C r e a t e  a Oesxn s o e c l f i c a c .  . 
@aucSor  <A k i R 3 T = " m a l l ~ e  :cL:vecs$aecL1 caC>Steoken O l r * ~  
@ v e r s i o n  0.10, Mar 3 .  2 

- /  
ouSl i c  cLas:DesianS~ecif icat ionEdit?r,  e x t e r . d : J I n t e r n a X r a n  

/ -- 
O KX!sri '~ln= cane  - 1 

D r i v a t t  JPaneS e d i t P a n e  = new J P a n e l  ; 
/ - O  

' Lavazt  t o r  t h e  u c c c r l v l n a  oar 
' I  

o r l v a t t  GridBaaLavou e d i t P a n e l L a v o ~  = zen Gr~dBaaLavou : 

/ * -  - a a n e l  f o r  cornmon TrXsaecCcmnonenc s a n c ~  
1 

D r l v a t t  TeXs~eccornoonentEditPar comonentPanc-  

/ * -  
Danel toc C C ~ - a n  s u e ~  suecLsxc C ~ ~ E C  - I  

o r l v a t t  D e s ~ a n S n e c i f i c a t i o n E d ~ t P a ~  desranPane;  

/ * *  
o a n e l  f o r  "SF\Vf" and "CANCEL" hucc 

1 

DElVaCt S a v e C a n c e l P a n ~  bu t tonPane  = ne* ÇaveCancelPanr ; 

/"  
Ceslar .  Data D r c t i o n a r v  e n t r v  :a b e  ertrced i zoc l  

1 

~ x i v a t t  D e s i a n s n e c i f  icat i* dsNer; 

/.+ 
d a t a  x c d c l  f o r  YajLe of d e s i o n  SD 

' I  

o r i v a t t  TeXsoecComnonentLab~eMoc dataMode. ; 

/ - -  
O Used f o r  s r n e c a t i n a  Lavaut c g n s t r a r  

. 
o r i v a t t  Lnt  curRoc = il; 



- 
* C r e a t e s  an l n s i a c c  

* e ~ a r a m  t l t l e  =te Strma =c d r s o l a v  IZ t h e  t ~ t l  
* eaararn r è s i z a b l e  r f  trie. t h e  frame can  b e  rt 
* enararn c i a s a b l e  r f  tr.Je. t h e  :rame can b e  < 
* eoarzm n i a x l x z a b l e  r f  t r x e .  zhe frame can  b e  a a x  
* eoaram r c ? n r f r a b l c  r f  t r ~ e ,  :he frame can  te L C O  

* eoaram d d e s r a c  Ç o e c ~ f ~ c a t r o n  cc be e. 
* eoaram nr d a t a x a d e l  f o r  JtabLc of s o e c r f x a t r o n s  w t l c h  sav b e  r 

I 

ouii l ic  DeslanSoeclficationEdstFri S t r l n c  tlt1,c. b o d e a z  r e s r z a b l .  
boolear c losabl . .  booleaz maxinuzabl, boolear ~ c o n i f i a b l .  
D e s i a n S o e c i f i c a t l  d. TeXsoecComoonentTableMoc m. 

s u o e : ~  trtlt. r e s r z a b l .  c l o s a b l ~ .  maxluuzabl. r c o n r f l a b l  ; 

c a t c t  Exceot lo .  e x  
ex.or1ntStackTrac ; 

/"  
* C r o a t e s  ar  i r s r a c c e .  Lsed t v  26u:tder 

* 

~ u b l i c  Des ianSpec~f i ca t ionEdstFr i  
t h l z .  "". t ruc.  t r ï e .  t r u c .  trut.  n u l l .  n u i l : :  

/" - 1 ~ l t l a : r :  

* 4  

o r l v a t t  v c i c  i b I n i t  , throu: Exceot ia .  

I / / . - .  set ~3 CC(IIIILÛG TeYscoc C O ~ D O Z ~ C L  ~ l ~ r n e x = s  FCC e< 
comoonentPane = aew TeXs~ecCom~onentEdrtPar~dsNeo~ : 

/ /  ... set xn des im caca a r c t i o c a r v  scecz:;c cienenCs ;or E 

d e s i a n p a n e  = new DesianS~eciLicationEditPa~~dsNek ; 

/ / .  . . set m t h e  Lrsrenero f o r  the "SAVE" 9 "CANCCL" b 
but tonPane.ae tSaveBut tc  , addAc t lonL~s fenc  
neu 7 av.?.aut.evèn t .Acc lonL~s f  enct 

o u b h c  v o i c  a c t i o n P e r f o m r  Acc~onEver,  
s aveBut ton  ac t ionPer fo ro :e  ; 



n e ï  iava,awt,event.ActionLrsï en€: 
oublie vo le  a c t i o n P e r f o r n ~ i A c t ~ o n E v e ~ ~  e :  
cancelButton ac t ionPerf0n:e :  : 

/ /.  . . s e c  un the xa ln  oar 
aeïContentPar, : .setLavou new GridBaaLavoul : 
aetContentParS .adc!comonentPane. 

new GrrdSaaCons t r a m  
0. 0 .  / /  arzd nos x. 
Gr~dBacConstrain-.REMAINDE . 1. 
/ I  urld widtk. h e ~ a  
1.c. 0.C. 
/ /  urichï x. 
GrrdBacConstrain..EASI, 
GrrdBaaConstrain-.HORIZONTA. 
! I arck-cr. f i l  
nch Insec: O. 0. 0 .  O . 
/ /  ::sec 
5, 2 
i/ c;rdx. osa 

metcontentpar .adc,desranPane. 
new Gr~d3aaConstraln 

O, 1, I f  a r ~ d  D O S  x .  
GrxiBacConstrain .REMAINDE, L. 1 
3r:d w ~ c t h ,  7e:cl 
1.:. L.C. 
I/ w e i c h t  Y .  
GrrdBauConstrain .EAST. 
Gr~dBacCons t r a m  .BOTE. ! / 
32C101. Zi- 
neu tnset i  O. 0, 0, O . 
;/ :-Sc: 
5 ,  2 
:i zadr. 3ab 

aerContentPar1 .adci buttonpane. 
new GridBaaConstra:n 

O ,  2, / f  .crrzd D O S  x. 
Gr~dBaaConstraln -REMAINDE. 1. / / 
o r A  wrcth. aei31 
1.C. O - c ,  
/ /  verch: x. 
Gr~dBacConstraln -EAST. 
Gc~dBacConstra~n .HORIZONTA. 
{ I  acctaz .  f-; 
new Inset:  O.  0, 0.  O . 
/ / x s e c  
5. 2 
i I cad:~. 3ad 

* Generaït Lavaut c o n s z r a x t t s  for m o s t  f 
* - g ~ a r a r n  ~ 1 3 t h  qrrS r r d t h  . < O  = end cf :zu. 87 = remalcder  
' I  

~ c ~ v a t t  GridBaaConstrain l a v o u t . i n t  uzdtt- 
zerurr Lavouti widtt. GrrdBaaCans train-.CENTZE' : 



@oaram ï i d t h  c r i d  w i d r t  (4  = end of row. 3 = r t rna lnder  
' eoararn anchor see Gr~dKauCons t r a  
* I 
Drrva:c GridBaaConstraLn- Lavou t f ln t  wldrt. I n t  anchoi: . 

GrrdBaaConstraln.  r e tVa l  = null ;  

r f :w id t t  <= O 
~f w ~ d t k = O  

w l d t t  = GrldBaaConscraln .REMAINDE ; 
e l s e  
w r d t t  = -widttr 

retVa1 = new GridBaaConstrain '  
Gr~dBaaConstrarn..RELATIV~, curRoWt. / /  z r r c  cos  x .  
widtt. 1. 
hezaht 
1.C.  O.C. 
anchoi, Grrd3aaCcr.strain ,BOTE. 
nek I n s e t :  O. 0. 0. O . 
O, 2 

elst 
retVa1 = ne* GcrdBaaCons t r a~n  

GrtdBaaConstrarn-,RELATIV. cu:Ror. 
w ~ d t t .  1. 
l.C, O.C. 
anchoi. Gr ld3aaCons t r a ln  .NONE. 
nek I n s e t :  O ,  0 ,  0, O . 
5. 2 

/ * '  
Genera te  favou: c=nst:al 

* Scaram w;dth c r ~ d  u l d t t  i c 3  = *na of rlu. 3 
* S ~ a r a m  anchor  sec G r ~ d t i a a c c z s r r a  
* s ~ a r a m  fil: see Gr~dGaaCcnstrA 

/ /  u e r a h t  x. 
/ /  t n c h c r .  £11 
/ /  Ln i ê t .  
/ nabx. n ad 

' I  

nrrvatc GrldBauConst ra ln-  l avou t i zn t  wrdtt. r n t  anchoi, r n t  fiIl 
GrrdBaoConstraln- retVa3 = null; 

r f  ' r f d t t  c= O; 
~f wrdti==O 

w r d t t  = GrldBaaCons=~aan..REMRINDEi 
e l s e  
w i d t t  = -widttr 

retVaJ = new GrtdBaaConstrarn.  
Gr~dBaaCons  trarn-AELRTfV. 
w ~ d t t .  1, 
herah f  
1-c. 0-1. 
anchoi. frU. 
@ o l l c l  
new i n s e t :  0. 0. 0. O . 
O. 2 

eLse 
retval = new GrzdBaaConstram- 

GridBaaConstrarr-.RELATfV:. 
widtt. 1. 
0-1. 0-1. 
anchoi. f r l L  

/ I Lnset. 
/ /  oacx. nad 



~ 0 1 1 ~ ;  
neu 1nset:iO. 0. 0. 01 . 
5. 2 . 

re iuzr  retval ;  

/ - *  - Rèsbona CO mauss-chck cn  Che "SAVE" uushb 

- Cbaram e evenc f rom - / 
o r l v a t c  vorc saveau t ton  a c t ~ o n P e r f o r n  ActlonZven e 

componentPan~.recordDat ; 
desianPane. recordDat r 
if* dsOlc-aetNam18 .equalc~dsNer.uetNamii 

dsNeb.co~vTc dsOlc ; 
t r v  

dsOlc,writc~ : 
buttonPane.aetCancelButtc .setTexl~"E:.rir" ; ; 

ca tc t l  TeXsoecExceDtic e x  
E x c e ~ t i o n D i a l c  d l a  = new Exce~tionDiaLc:Confiauratio. 
ae t l i e f au l t f r an .  , "le:<sctc. trucTeXs~ecExceptic.er:or, 
"Could no t saüe Des:anDL+" "+ex.descrm t i o  . ; 
Dlmenslo. d laSi rc  = dLc. a e t  PreferredSr:: ; 
Dimensio frrnSizt = a e t S ~ z t  : 
Point l o c  = ae tLoca t io  ; 
d l a - s e t l o c a t i o  fsmSizt.widtk - dlaSizi.widtt / 2 + lac-x. 
frmSitc-heiaht - dlaS~zt .heraht .  / 2 + Loc-v ; 
dla.shok1 ; 

elst  
t r v  

d s N e i - w n t t i  ; 
buttonPane.aetCanceLButtc~ .setTextt"Exr t" ; ; 
if: dataMode != nul1 dataMode -addComDonen dsNeu' : 11. . . 
uodatè J t a b l  

c a t c t ,  T e X s ~ e c E x c e ~ t i c  ex 
E x c e ~ t i o n D i a l c  d l a  = neu ExceotionDialc C o n f ~ a u r a t i o .  
aetDefaultFran . "Texscêc , ~ ~ u € , T ~ X S D ~ C E X C ~ D ~ ~ C . ~ ~ K O ~ ,  
"CouLc! noc c r e a t e  r,ew Desicr,iWn '+ex .d€Scr~~t iO : 
Cimensio. d l c t s ~ z t  = dLc.sret?ref erredSr: ; 
Drmer.slo f r m S ~ z t  = aetSizc : 
Point Loc = ae tLoca t io  ; 
dla . seÊLocat ro~ frmSlzt.uidtt - dluSizr-wxdtt / 2 + lot-x. 
frmSizi.heisht - dlsSizc-heiuhti / 2 + loc-v ; 
d la - shob  ; 

/ -- - J e s ~ o n c i  to mouse-c l~ck  o n  C h e  "CANCEL" ~ ~ l i t  
t 

* h a r a m  e evenc ? r o m  c 

- /  
o r l v a t t  voie cancelButton a c r i o n 2 e r f o n ~ A c a c n E v e n  e 

d i s ~ o s t  ; 



E Installation 

Qbpec on a number of twls which are avaihble without charge and can be downioadecl h m  various 

hternet sites. These tools cari be installecl on various computing piatforms. Each of these twh must be 

installeci on a system before m e c  c m  be installed. l&bpec should operate on any platfonn where each 

of these bols has been instded. 

The main Q$spec processing is performed by modules which have been implemented in PERL [28], Perl 

Version 5 was used to develop 'QXipc, and earlier versions are unlikely to be compatible. 

Various distributions of m and Wi)$ exist for many piatforms. î)$qec bas been tested on the Te'&$ 

and MiicQjC distributions, but should be compatible with any other vdid distribution. 

Some distributions do not contain the xy-pic package which provides drawing capabities Chat 'Il.I;Xspec 

uses to produœ Data Flow Diagrams and Structure Charts. or the vmargin package, which 'Q$qx uses 

to cantml margins. if the selected distribution does not inctude either of these pachges, then the missing 

prrckage(s) must be downloaded and instaüed within the instdation. Enstallation of extension packages 

is detailed in documentation of the QX distribution. 

E.1.3 Naweb 

Noweb is a combination of executable programs and a Wi)$ extension package. Detailed installation in- 

structions are provided for various piatforms wÏth the Noweb distribution. 

Microsoh WmdowsNT users shouId be aware of the incompatibüity of Wmdows-NT with the N m b  dis- 



tribution biia (executable images) Far other Micraeoft Wmdows systems. Instructions are included with 

the Noweb distribution for building NT bies. 

E.1.4 JAVA Runtime Envimnment 

Users wishing to run the GraphicaI User Interface must W a Java Runtime Environment that indudes 

the "Swing" Iibtaries- T)$qec has been tested on Sun Mcrosystem's JRE version 1.2 and 1.3, but 'Q#pec 

should be compatible with any Swing enabled environment. 

E.2 T w e c  Specific Installation 

The Ti-)Espec distibution includes: 

A number of Perl scripts. If W p e c  is to be nin from the command line. then some platforms prefer 

these to be placed in a particular location. if the GUI is to be used, then the scripts can be placed 

anywhere provided that the GUI searc6 Iist is updated to look in that location, 

GUI "batch" fites, For each Ped s~npt ,  a He is requireà to interface between the GUI and Perl. 

The ïj$spec distribution includes amples for MicrosoR Windows environments. These Hea are ody 

quired if the Güi is to be used, and can be p M  anywhere provided that the GUI search I i i  is 

updated to look in that location. 

a A Java ARchive (.jar) file containing the executabte GUI. This can be placed anywhere. provided that 

the Java Runtime Environment can ac- it. 

a A cl- (.ch) He for each publiskble product. These m u t  k ptaced in the W&X installation. Instal- 

lation of new class ûies is detailed in documentation of the distribution. 
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AECL Atomâc Energy of Canada Ltd 

API Application Progrom Interface A set of routines, pmtocols, and tools for building software applications. 

An API facilitates program development by providbg pre-defined components. 

ASCII Am- Standard Code for Information Interdrange A code for representing Enghh characten 

as numbers, with each letter essigneci a nurnber h m  O to 127. 

CASE Computer Aided Software Engineering A category of soRware that provides a deveioprnent envi- 

ronment for software prognunming. CASE systems offer tools to automate, manage and simplify the 

development pmcesa. 

CERN European Labonttory for Particle Physics European Organization for Nuclear Research, the worid's 

iargest particle physics centre. 

CNSC Canadion Nudear Safety Commission Regulator of nuclear energy and materials in Cenada 

configuration management system A system to identify and manage change, keeping a record for his- 

torical reference, 

CP/M Contml Progmm for Microproeessm Created by Digitai Research Corporation, CP/M was one of 

the Lirst operating systems for personal cornputers. 

C S A  Canadian Standanis Association A not-for-profit, nonstatutory, voluntary membership ~ c i a t i o n  

engageci in standards deveIoprnent and certincation activities. 

Symbolic Debugger A program used to find defects (bugs) in other pmgrams. A debugger ailows a 

programmer to stop a program at a specified point and examine and change the vdues of variables. 

DFD Dota Row Diqmrn A high Ievel abstraction of software requirements showing conceptual processes 

and the Bow of data between them. 

Deeign Speciûcation The specification for a single compiiabk rnodde. 

GUI Gmphical User In ter f i  Pronounced gowe. A program interfece that cakes advantage of the corn- 

puter's graphics capabiities to make the program easier to use. Weiidesigned graphicd user interfacoi -- FZm b L  .mr C1*m Lrrkrr m-r.lnr mmmnnA lsnmtormo 
ULY L L W  -LW YLU ..- -- ....-y.- - - . Y -  --- 



ISO Inîernationd Organüation fw Standardüation Derived h m  the greek word iso, which meanrr equal. 

Founded in 1946, ISO is an international organization composed of national standards bodies from 

over 75 countries. 

Java A generai purpose, high-level progamming language developed by Sun Microsystems. Java is an 

object-orienteci language s h i h  to C++, but simplined to eüminrite Ianguage fëatures that cause 

cornmon programming emrs. Java source code files are compileri into a f a m t  called bytecode, which 

can then be executed by a Java interpreter. Compiled Java code can r u  an m& cornputers because 

Java interpreteni and runtime environments, known as Java Virtuai Machines (Wh), exkt for m a t  

operating systems, including ITNDI, the Macintosh OS, and Widws. Bytecode can aiso be converted 

directly into machine Ionguage instructions by a 'just-in-time' cornpiter- 

BQ?t A typesetting system bued on the wprogramming Ianguage developed by Donaid E. Knuth. Most 

peopIe who use '&Xutilize a macm package that provides an &er interface. WQ$, originally written 

by Leslie Lemport, is one of the most popular, -provides higher-lewl macros, which makes it 

easier to format documents but slrcrifices some of the tiexibility ofî&C 

Macintosh A popular mode1 of personai computer made by Appie Cornputer, fëaturing a graphicd user 

interface to nrake it relatively easy for novices to use the computer productively. 

MathType An interactive mi for Wmdows and Macintosh fkom Design Science inc that assists in the 

creation of mathematicd notation for word pro-ng, and for W a n d  MathML documents 

Mini-spec Aocesa Spca$cBtion The description of what is happening in a bottom levei, primitive bubbIe 

in a datafiow diagram. 

MS-DOS MicroSoft Diak Operolkg System Originally developed by MicrosoR for IBM, MSDOS wss the 

standard operating Wern for IBM-compatibIe personal computen 

MS-Win Micmsoft Wmdows A famiIy of operating systems for personal computers owned by Microsoft 

Inc. 

N286.7 CSA Standard for the Quality Assurance of Anaiytid, Scientific, and Design Computer Programs 

for Nudear Power Plants. 

00 Object CXentad A speciai type of that combines data stnictures with functions to create 

musable abjects. 

OPG Ontario Pmuer Ceneration A Company owned by the Govenunent of Ontario whicà operates the 

majority of Canadi= nudear rractors. 



PC Persond CornpuCm The first persona[ cornputer produced by IBM was called the PC, and increaaingly 

the term PC came to mean B M  or [BMampatibie personal computers, to the exduaion of other 

types of personal computers, such as Mncïntashes. 

PERL Pmcticol ihtraction und Repwt Languoge A programmhg hguage developed by Lamy WaII, 

especially designed for pmcessing text. Pet1 is an interpretive lm-, which makes it eaay to buiId 

and test simpIe program. 

Structure Chart An abstraction of software deaign sbowing software modules, d y  as a tree, and the 

tIow of data between them. 

search List A List of directories to be searcheci sequentidly for a ide of a given m g  The accuence of the 

file at a higher 1eveI in the ht effectîvely superceeda fles of the same name in directories lower in the 

ri. 

SGML Standard Cmducd Mankup Language A system for organiaing and tagging elements of a doc- 

ument. SGML was dewloped and standardized by the ISO in 1986. SGML itseIf doeo not speciFy 

any particuiar fomtting; rather. it speciiïes the d e s  for tagging elernents. These tags can then be 

interpreted to format elements in Merent ways. 

TCM ToolrCit for Conccptud Modrlinq RJ. Wieringas' coUection of software tools to present conceptual 

models of software systems in the form of diagrams, tables, txees, and the like. 

TRADE Toofkit for Requimmta And Design Engineering R.J. Wierhgas' TooIkit for Requirernents And 

Design Engineering. 

UNaC Pronounceci ~OMI&S. A popular mdti-wr, multitasking operating system dewloped at Bell Cabs 

in the e d y  19708. 

W3C W d  Wide Wei Cmmtiurn An international consortium of corndes invotved with the internet 

and the Web. 

XML EzteMible Markup hnguuge A specification devetoped by the W3C. XiML is a petwl-dm version 

of SGML, deigned especidy for Web documents. It dows designers to create th& own customized 

tags, e n a b h g  the debition, transmission, validation. and interpretation of data betweea applications 

and between orgaubtions. 

X-Widows A windowing and graphics system deoeloped at the hkaachusetts institute of T h i o g y .  

Almost al1 IiMX graphitai intedeces are based on X-Wmdow. 
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